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Preface

Thank you for purchasing this Sokkia product. The materials available in this Manual (the “Manual”) 
have been prepared by Topcon Positioning Systems, Inc. (“TPS”) for owners of Sokkia products and 
are designed to assist owners with the use of the receiver and its use is subject to these terms and 
conditions (the “Terms and Conditions”).

Terms and Conditions

Use
This product is designed to be used by a professional. The user should have a good knowledge of the 
safe use of the product and implement the types of safety procedures recommended by the local 
government protection agency for both private use and commercial job sites.

Copyrights
All information contained in this Manual is the intellectual property of and copyrighted material of TPS. 
All rights are reserved. Do not use, access, copy, store, display, create derivative works of, sell, modify, 
publish, distribute or allow any third party access to, any graphics, content, information or data in this 
Manual without TPS’ express written consent and may only use such information for the care and 
operation of the receiver. The information and data in this Manual are a valuable asset of TPS and are 
developed by the expenditure of considerable work, time and money and are the result of original 
selection, coordination and arrangement by TPS.

Trademarks
Sokkia®, Sokkia® GNSS Receiver, GeoPro, Topcon Integrated Leveling TechnologyTM (TILT), Fence 
Antenna® technology, Vanguard TechnologyTM, SiteComm, Quartz Lock LoopTM TopNET®, 
MAGNET® Field, Topcon® and Topcon Positioning SystemsTM are trademarks or registered 
trademarks of TPS. Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® 
word mark and logos are owned by Bluetooth SIG, Inc. and any use of such marks by Topcon 
Positioning Systems, Inc. is used under license. Other product and company names mentioned herein 
may be trademarks of their respective owners.

Disclaimer of Warranty
EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE 
PRODUCT, THIS MANUAL AND THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER 
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE 
FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING, 
PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED DAMAGES 
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF 
PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT 
RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH 
OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR 

NOTICE Please read the terms and conditions carefully.
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ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR 
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE 
FOR THE RECEIVER. 

License Agreement
Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the 
“Software”) in connection with the receiver constitutes acceptance of these Terms and Conditions in 
this Manual and an agreement to abide by these Terms and Conditions. The user is granted a 
personal, non-exclusive, non-transferable license to use such Software under the terms stated herein 
and in any case only with a single receiver or single computer. You may not assign or transfer the 
Software or this license without the express written consent of TPS. This license is effective until 
terminated. You may terminate the license at any time by destroying the Software and Manual. TPS 
may terminate the license if you fail to comply with any of the Terms or Conditions. You agree to 
destroy the Software and manual upon termination of the use of the receiver. All ownership, copyright 
and other intellectual property rights in and to the Software belong to TPS. If these license terms are 
not acceptable, return any unused software and manual.

Website; Other Statements
No statement contained at the TPS website (or any other website) or in any other advertisements or 
TPS literature or made by an employee or independent contractor of TPS modifies these Terms and 
Conditions (including the Software license, warranty and limitation of liability). 

Technical Documentation and Utility Software
On the Sokkia Support website (https://us.sokkia.com/sokkia-care-products/sru-sokkia-receiver-
utility), you can download technical documentation, training material, and various utility software to 
help you set up and use your Sokkia product. The website also offers registration resources, training, 
and technical assistance. 

Although the support documentation, firmware and utility software for the Sokkia GRX3 can be found 
at the Sokkia Care site, the product registration is done via the myTopcon site/or by using the 
myTopcon NOW! app.  It is free to create an account and register. 

Safety
Improper use of the receiver can lead to injury to persons or property and/or malfunction of the 
product. The receiver should only be repaired by authorized TPS warranty service centers.

Miscellaneous
The above Terms and Conditions may be amended, modified, superseded or canceled, at any time 
by TPS. The above Terms and Conditions will be governed by and construed in accordance with, the 
laws of the State of California, without reference to conflict of laws.
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Manual Conventions
This manual uses the following conventions:  

Convention Description Example

Bold Menu or drop-down menu selection File > Exit (Click the File menu and click 
Exit)

Name of a dialog box or screen From the Connection screen...

Button or key commands Click Finish.

Mono User supplied text or variable Type guest and click Enter.

Italic Reference to another manual or help document Refer to the Sokkia Reference Manual.

NOTE Further information to note about system configuration, maintenance or setup.

NOTICE
Supplementary information that can have an adverse affect on system operation, 
system performance, data integrity or measurements.

CAUTION
Notification that an action has the potential to result in minor personal injury, 
system damage, loss of data or loss of warranty.

WARNING
Notification that an action has the potential to result in personal injury or property 
damage.

DANGER
Notification that an action has the potential to result in severe personal injury or 
death.
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Introduction

The Sokkia GRX3 GNSS receiver is a compact, high-performing integrated GNSS receiver for static 
and kinematic land surveying applications. The receiver design includes 226 GNSS channel Vanguard 
Technology with Universal Tracking Channels and advanced integrated Fence Antenna technology. 
These technologies deliver world class positioning and navigation capability to your application by 
tracking signals with multiple frequencies and multi-constellation satellite systems such as GPS, 
GLONASS, BeiDou, QZSS, Galileo, NavIC, and SBAS.

To create a future proof, efficient positioning system this receiver combines; GNSS tracking 
capabilities, multiple-frequency RTK, DGPS and PPP solutions, extensive communication capabilities, 
a built-in 8 GB memory and an integrated internal battery.

Several unique features, including advanced multi-path mitigation, adjustable Phase Locked Loop 
(PLL) and Delay Locked Loop (DLL), offer reliable and versatile reception of weak signals even in 
degraded signal environments. The receiver also supports Quartz Lock Loop (QLL) technology for 
superior GNSS tracking in high-vibration environments.

The GRX3 receiver contains an internal HIMU (Hybrid Inertial Measurement Unit) module. This module 
measures tilt angles of the rover receiver. The angle values are used by the software application 
MAGNET Field for calculating the true projection of the rover antenna phase center on the ground.

The GRX3 GNSS Receiver offers complete IP67 protection against dust and water ingress, in addition 
to superior vibration and shock resistance. The Sokkia communication interface allows you to integrate 
GNSS performance and quickly deliver world class positioning and navigation support to your 
applications.

Figure 1-1: GRX3 Receiver
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GRX3 Features
The GRX3 GNSS receiver’s advanced design provides simplified setup and maximum performance. 
The GRX3 receiver features are as follows:

● 226 GNSS channel Vanguard Technology with Universal Tracking Channels for multi-frequency 
tracking of multiple satellite constellations such as GPS, GLONASS, BeiDou, QZSS, Galileo, 
NavIC, and SBAS.

● Industry leading Fence Antenna technology

● Internal, non-removable battery

● Internal UHF radio modem

● Optional Multi-band 4G/3G/2G internal cellular module

● Integrated Bluetooth, multi-channel SiteComm technology

● Interface for controlling and viewing data logging through the LED display

● Topnet Live Starpoint (Pro) global Precise Point Positioning (PPP) correction service

● TILT—Topcon Integrated Leveling Technology

● External power, USB and serial-data ports

● External GNSS antenna connector for GRX3 series receivers without an internal cellular module

● External cellular module antenna connector for GRX3 series receivers with an internal cellular 
module

● Internal 8 GB memory storage

● Virtual serial port via USB

● Data access using USB 

The GRX3 comes in one of the following configurations:

● No cellular module

● Integrated 4G/LTE cellular module only

● R2 Lite UHF radio, with integrated 4G/LTE cellular module

● Alinco UHF radio (available in Japan)

● Alinco UHF radio (available in Japan), with integrated 4G/LTE cellular module 
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Unpacking Your Receiver Kit
This section describes the documentation, standard kit components1 and accessories that 
accompany your receiver. When you unpack your receiver kit, verify that you received the items listed 
in this section. If any items are missing or damaged, contact your local Sokkia dealer. See “Getting 
Technical Support” on page 1-4.

Standard Kit Components
Table 1-1 lists the standard kit components for the GRX3. For more information about the included 
cables, see “Cables” on page 2-6.

Accessories
Sokkia offers a wide variety of accessories specially designed to improve system flexibility and job 
site efficiency. For more details on the optional accessories available for GRX3, contact your Sokkia 
dealer.

Table 1-2 lists the accessories available for the GRX3. For more information about accessories, see 
“Accessories” on page 2-8.

1. Components in the standard kits may differ based on your country or region. Contact your local Sokkia dealer to 
inquire about items included in your regional standard kit and accessories that are available with the receiver.

Table 1-1. GRX3 Standard Kit Components

GRX3 Receiver Power Cable

Power Adapter Wall Charger Cable

Micro-USB Cable Serial Cable

GRX3 GNSS Receiver Quick 
Reference Card (P/N 1030648-01) 
– Describes the LED behavior and 
technical content.

Warranty Card

Radio Antenna Cellular Antenna (with cellular variants only)

Table 1-2. GRX3 Accessories

Radio Antenna Rover Pole

External Antenna Cable Prism

External Cellular Antenna Fixed Height Heavy Duty Tripod

Rover Pole Offset Adapters Economy Tripod

Tribrach with Plug Adapter Tape Measure

Hand-Held Controller and Brackets Prism Adapter
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Technical Documents
The following documents will help you set up and use your new receiver.

● GRX3 GNSS Receiver Operator’s Manual (this document)—contains detailed information on how 
to use your new receiver. You can download the document from the Sokkia Care support site 
(https://us.sokkia.com/sokkia-care).

● GRX3 GNSS Receiver Quick Reference Card (P/N 1030648-01)—contains basic hardware and 
LED descriptions, along with safety and regulatory statements. This guide is available in your 
standard kit package.

● Sokkia Receiver Utility (SRU) Help —an on-screen help document embedded in the software that 
contains detailed information on how to use the SRU software. For more information about the 
SRU software, see "Using Sokkia Software With Your Receiver".

Using Sokkia Software With Your Receiver
Use the GRX3 receiver in conjunction with the Sokkia Receiver Utility (SRU) and MAGNET Field data 
collection software or Pocket 3D machine control system applications for a precision positioning 
solution. Sokkia software enables you to configure the receiver and other external devices, manage 
files, collect data and perform survey and construction work flows.

The Sokkia Receiver Utility (SRU) is a software program that enables users to configure and update 
their GNSS receivers and peripheral devices. You can install it on desktop computers and data 
controllers. You can download this program from Sokkia Care (https://us.sokkia.com/sokkia-care). 
The help document for SRU is embedded in the software.

Topcon’s MAGNET Field and Sokkia GeoPro Field software for data controllers provides real-time 
communication, cloud storage, data collection and exchange and field solutions—such as 
topographic staking, roads, calculations and more.

Pocket 3D is a machine control system application for the survey and construction markets. The 
software runs on data controllers with Windows CE and mobile platforms. Pocket 3D simplifies data 
collection, allowing you to check cuts and fills, layout points and survey all or part of the job site 
quickly and efficiently.

Contact your Sokkia dealer for more information about Sokkia field data collection software for the 
surveying and construction markets.

Getting Technical Support
Before contacting a Sokkia customer representative about any problems with the receiver, see 
“Troubleshooting” on page 8-1 for some solutions that may fix the issue.

Contact your local Sokkia dealer or visit Sokkia Care (https://us.sokkia.com/sokkia-care) for 
technical support.  

When contacting Sokkia for technical assistance, provide the following information for better and 
faster service:

NOTICE For quick and effective support, provide a detailed description of the problem.

(https://us.sokkia.com/sokkia-care)
(https://us.sokkia.com/sokkia-care)
https://us.sokkia.com/sokkia-care
https://us.sokkia.com/sokkia-care
https://us.sokkia.com/sokkia-care
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1. A description of the following:

■ The field operation that was being performed when the problem occurred.

■ Details of the unexpected behavior, symptoms and any error messages that precede or follow 
the problem.

■ Problem occurrence frequency or patterns.

2. Gather your receiver information and configuration settings. To obtain the receiver information:

a. Install SRU on a hard drive of a field controller or personal computer.

b. Use a serial or USB cable for connection.

c. Run SRU, switch on the receiver.

d. Select Device > Application Mode > Receiver Managing.

e. Select Device > Connect.

f. Click the Connect button on the Connection Parameters screen to establish a 
communication to the receiver.

g. Click Information  on the Main menu of SRU. 

The Receiver Info screen opens (Figure 1-2). It displays basic receiver information, such as 
hardware and firmware versions, RAM size, receiver ID, serial number and so forth.

h. Click Save to File. 

Figure 1-2: Save Receiver Info to File
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i. Enter a File name and click Save on the Save As window to save it to your computer. 

Figure 1-3: Save Receiver Info

3. Specifications of mobile devices and computers used in the field or office exhibiting the 
problem. These specifications should include model information, version number, operating 
system information, memory and storage capacity.

4. Information about the system software, including the version number and steps to reproduce 
the problem.

5. A description of the field environment and/or observation conditions when the problem 
occurred.

Website
The Sokkia website provides current information about Sokkia’s line of products. The support area 
of the website provides access to Sokkia field and office software, manuals and frequently asked 
questions. To access the Sokkia corporate website, visit https://sokkia.com.

The Sokkia Care support and training website provides support for Sokkia registered users. Sokkia 
Care provides information about Sokkia products, training, events, firmware and software updates 
and troubleshooting procedures. To access this content visit https://us.sokkia.com/sokkia-care.

GRX3 GRX3

https://sokkia.com
https://sokkia.com
https://us.sokkia.com/sokkia-care
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Getting Acquainted

The GRX3 receiver enclosure is fully sealed and may incorporate a GNSS receiver board, multiple 
modems, multiple antennas, a battery, memory storage and wireless communication modules that are 
enclosed in a rugged housing. The upper part of the receiver includes both GNSS and Bluetooth 
antennas that are covered by a Radome and is securely surrounded by a shock absorbing rubber 
bumper.

Receiver Enclosure—Overview
Currently, there are five (5) configurations of the GRX3:

● No radio, no cellular module

● R2 Lite UHF radio 

● R2 Lite UHF radio, with integrated 4G/LTE cellular module

● Alinco UHF radio (available in Japan)

● Alinco UHF radio (available in Japan), with integrated 4G/LTE cellular module 

Figure 2-1 shows a GRX3 GNSS receiver without radio modems or a cellular module (P/N 1028556-
02). The lower part of the receiver contains the External GNSS antenna connector. The Reset button 
is located under the SIM card door in the lower part of the receiver.

Figure 2-1: GRX3 without Radio Modems or a Cellular Module

1. Reset button 3. External GNSS antenna connector

2. SIM card door

2

31
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Figure 2-2 shows a GRX3 GNSS receiver with an R2 Lite UHF modem (P/N 1028556-01) and 
without a cellular module. The upper part of the receiver includes a connector for the radio modem 
antenna. The lower part of the receiver contains the external GNSS antenna connector. The Reset 
button is located under the SIM card door in the lower part of the receiver.

Figure 2-2: GRX3 with a UHF Without a Cellular Module

Figure 2-3 shows a GRX3 GNSS receiver with an R2 Lite UHF modem (P/N 1028556-05) and with a 
cellular module. The upper part of the receiver includes a connector for the radio modem antenna. 
The lower part of the receiver contains the external cellular module antenna connector. The Reset 
button and SIM card slot are located under the SIM card door in the lower part of the receiver.

Figure 2-3: GRX3 with a UHF With a Cellular Module

1. Reset button 3. External GNSS antenna connector

2. SIM card door 4. External radio modem antenna connector

2

31

4

1. Reset button 4. External cellular module antenna connector

2. SIM card slot 5. External radio modem antenna connector

3. SIM card door

3

4

5

21
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Receiver Enclosure—Display Panel
The receiver’s lower part is made of a magnesium alloy and contains a display panel.

Figure 2-4: Lower Part of Receiver—Display Panel

The display panel enables you to view the receiver’s operational status. For more information about 
the display panel’s operational status see “Display Panel” on page 3-1.

Receiver Enclosure—SIM Card Door 
The SIM card door (Figure 2-5 on page 2-4) is located to the left of the LED Display Panel. To remove 
the SIM card door from the GRX3 use a flat blade screwdriver and remove the two screws. The 
Reset button is located under the SIM card door. For the GRX3 receivers with cellular module(s) 
installed, the SIM card slot is located there, too. 

1. Power button 2. Display panel

1

2

NOTICE
The GRX3 receiver’s GSM functionality is enabled when the Micro-SIM Card is 
installed. 

NOTICE Cellular operation is based on subscribed services.

NOTICE The SIM Card usually remains inside the receiver.
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The cellular module with SIM card installed is accessed via MAGNET Field, Magnet Construct or SRU 
for configuration purposes. Additional Micro SIM cards can be purchased by the user.

Figure 2-5: Removing the SIM Card Door

Receiver Enclosure — GRX3 Hardware Reset Button
If the GREX3 receiver stops responding via the Power button (Figure 2-4 on page 2-3) or the external 
software—perform a hardware reset. A hardware reset should only be performed when the GNSS 
receiver is powered on and not otherwise responding.

To perform a hardware reset:

1. Remove the SIM Card Door using a flat blade driver to remove the two screws (Figure 2-5).

2. Insert a paper clip or any pointed stick small enough to fit into the pinhole of the Reset Button.

3. Gently press the Reset Button for about one second until the GRX3 powers off.

4. After the Reset Button is released, the GNSS receiver is automatically powered on.

5. Close the SIM Card Door and install the two screws.

1. Reset button 3. SIM card door

2. SIM card slot (optional) 4. Screw (2)

3

2

4

1

WARNING
A hardware reset does not erase the “*.tps” data file(s) stored in the receiver’s 
internal memory and does not change the user’s settings entered in to the 
receiver. 
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Receiver Enclosure—Bottom Overview Labels

Attached to the bottom of the receiver enclosure are the regulatory and product identification labels. 
The product identification label contains the serial number (S/N) and part number (P/N) 
(Figure 2-6) for the receiver.

Figure 2-6: Bottom Enclosure Overview with Product Identification and Regulatory Labels

1. Reset button 3. SIM card door

2. SIM card slot (optional) 4. Screw (2)

1. Regulatory label 3. Serial number

2. Part number 4. Product identification label

1

3

4

2



G
etting A

cquainted

Cables 2-6P/N: 1030371-01

Cables
The GRX31 package includes a power supply cable, a USB cable and a power adapter. Table 2-1 
describes the cables included with your receiver—depending on your regional standard kit 
configuration. Make sure to contact your local Sokkia dealer to inquire about standard items included 
in your receiver kit.

1. Components in the standard kit may differ based on your region. Contact your local Sokkia dealer to inquire about 
items included in your regional standard kit and accessories that are available with the receiver.

NOTE
Align the keyways when connecting the power/serial cable to the receiver 
connectors. To disconnect the cable, push the cable in and then gently remove the 
cable.

Table 2-1. Receiver Cables

Cable Description Cable Illustration

Power Charge Cable(s)
These two cables connect to the power 
adapter to a grounded outlet. Several 
options are available for the power charger 
cable based on your country. To purchase 
this cable, contact your Sokkia dealer. 
Refer to this part numbers:

P/N 1005793-01 - Cable, Power Charger 
(US)
P/N 1005794-01 - Cable, Power Charger 
(EUR)
P/N 1021180-01 - Cable, Power Charger 
(AUS)

See Figure 2-7 on page 2-7 and 
Figure 2-8 on page 2-7.

Receiver Power/Charging Cable
Connects the receiver and the power 
supply unit via SAE connectors for battery 
charging.
P/N 14-008016-04LF 

Micro-USB Cable
Connects the receiver to an external 
device (controller or computer) for data 
transfer and receiver configuration.
P/N 1013602-01

Serial Cable
Connects the receiver to an external 
device (controller or computer) for data 
transfer and receiver configuration.
P/N 14-008005-03
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Figure 2-7: Power Charge Cable—US P/N 1005793-01

Figure 2-8: Power Charge Cable—Europe P/N 1005794-01

Alligator Clips Cable (Optional)
Connects any 12-volt DC power source to 
the receiver via the SAE cable.
P/N 14-008025-01

SAE-to-SAE extension cable (Optional)
Connects SAE connectors over longer 
distances.
P/N 14-008022-01

External Antenna Cable (Optional)
Connects the receiver to an external 
Sokkia GNSS antenna.
P/N 1006447-01

Table 2-1. Receiver Cables (Continued)

Cable Description Cable Illustration
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Accessories
Sokkia offers a wide variety of accessories specially designed to improve system flexibility and job 
site efficiency. For more details about the available accessories, contact your Sokkia dealer.1

● Power Supply Unit (P/N 1005555-01): This item charges the internal battery when connected to 
a grounded outlet. This unit converts the Alternating Current (AC), normally supplied from an 
electrical outlet, to Direct Current (DC) for charging the battery and/or powering the receiver.

● Modem Antenna: The UHF antenna is a BNC connection, the UHF frequency is 420-450 MHz 
(P/N 30-070003-01) and UHF frequency is 440-470 MHz (P/N 30-050501-01).

● Cell Antenna (P/N 1030630-01): This antenna is for use with the GRX3 versions that contain the 
integrated cellular modem. See Figure 2-3 on page 2-2 for the antenna location. 

● Universal Tribrach and Tribrach Adapter2 (P/N 22-006008-01 and P/N 22-006009-01): These 
items level the tripod and secure the receiver or antenna to the tripod.

● Precision Tribrach Adapter: This item precisely centers, aligns and levels the tripod over a point. 
The horizontal spacer (P/N 51842) inserts into the precision tribrach and allows the receiver to sit 
securely on the precision tribrach.

● Wooden Tripod (P/N 751252)

● Heavy Duty Tripod (P/N 22-050501-01)

● Two (2) Meter Fixed Height Rover Pole (P/N 808016)

● Field Controller: This item allows the GRX3 Base and Rover systems to be configured and 
monitored directly in the field. Use the Sokkia Receiver Utility (SRU) to configure the receiver and 
Topcon’s MAGNET Field and Sokkia GeoPro Field software.

● MAGNET and Pocket 3D machine control software: These items can be used to operate the 
receiver. See the SRU Help (embedded in the software) or the help files in the field collection 
software for more information.

● Fusion Positioning Adapter (P/N 1003241-01)

● 100 mm Prism Spacer (P/N 51949)

● Tape Measure (P/N 22-050902-01) HV1034DM 3/4 x 12 ft./3.7 Meters PWR Tape 10ths.

1. Some accessories may be included in the standard kit for your region. Contact your dealer for details.

NOTE
For additional information about antenna part and serial numbers, see Table 10-1 on 
page 10-1.

2. The universal tribrach and tribrach adapter are not needed when using a heavy duty tripod.
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Battery
The receiver has an internal, non-removable, rechargeable battery. The internal battery has two 
battery cells (packs) (Figure 2-9). For more information about using the battery see “Managing 
Power” on page 4-1.

Figure 2-9: GRX3 Internal Battery

1. Internal battery
(two battery cells/packs—bottom view)

1
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External Connectors
The GRX3 has the following external connectors.

Receiver Enclosure Top—Connectors
Radio Modem Antenna Connector—The radio antenna of the UHF radio modem plugs to the external 
antenna connector on the GRX3 radome. The radio antenna uses a reverse polarity TNC or BNC 
connection depending on the installed radio modem. For additional Specification information see 
Table 9-3 on page 9-8.

● A BNC connector is used for the UHF modem (Figure 2-10). 

Figure 2-10: BNC Connector for UHF Modem

1. BNC connector

1
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Receiver Enclosure Bottom—Connectors 
See Figure 2-11.

● Power connector—outlined in red. This connector is used to connect the receiver to an external 
power source. This connector can also be used to charge the battery. The body of the connector 
on the corresponding cable is red. For additional specification information see Table 9-6 on 
page 9-10.

● Serial connector—outlined in green. This connector is used for data communication between the 
receiver and an external device. For additional specification information see Table 9-7 on 
page 9-10.

● Micro-USB connector—outlined in yellow. This connector is used for high-speed data transfer 
and communication between the receiver and an external device. For additional specification 
information see Table 9-8 on page 9-11.

● GNSS radio antenna connector (optional, available only within non-cellular receivers)—outlined 
in blue. The SMB connector that is used to connect an external GNSS antenna for use in both 
base and rover stations. This connector is not present in a GRX3 receiver with a cell module.

● Cellular module antenna connector (optional, present only within integrated cellular receivers)—
outlined in blue. The SMA connector that is used to connect an external cellular antenna. This 
connector is present in the GRX3 series with cellular module(s).

Figure 2-11: Receiver Enclosure Bottom-Connectors (based on configuration)

1. Power 4. GNSS radio antenna connector

2. Serial 5. Cellular module antenna connector

3. Micro USB

1 32 4 1 32 5
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Display Panel

The receiver has a highly-visible display panel with single-button operation. The LED display panel 
(Figure 3-1) allows for control of receiver power and data recording. The LEDs display the status of the 
satellite tracking, recording raw data to the internal memory, Bluetooth connections, cellular module 
status and battery state of charge. This chapter describes the different LED blink patterns and what 
they mean.

Figure 3-1: LED Display and Power Button Panel

Power Button
The power button (Figure 3-1) performs multiple functions. The duration in which the button is pressed 
and held determines how the receiver will perform. While pressing the button, the LED panel indicates 
the selected operation using particular LEDs. Table 3-1 describes how to use the power button.

1. Power button 2. Display panel

1 2

Table 3-1. Power Button Functions and Descriptions

Function Press Button LED Description

Power On 2 seconds Release the Power button when the STAT LED 
turns solid green. The Power LED blinks until 
startup completes. After that the LED light is 
solid green, if the external power source is 
connected to the receiver. If the external power 
source is not connected to the receiver, the LED 
is OFF.
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LED Display Panel

Power Off 3-10 seconds Press and hold the Power button for more than 3 
seconds but not more than 10 seconds.
Release the Power button when the STAT LED 
turns yellow.

Start/Stop Data 
Logging

Press the Power button 
three times in a row 
within 2 seconds

Refer to the REC (Recording) LED description.

Toggling between 
Static and 
Kinematic post-
processing modes

Press the Power button 
three times in a row 
within 1 second.

Refer to the REC (Recording) LED description.
This function is available for “Occupation mode 
switch” only. See Sokkia Receiver Utility (SRU) 
Help.

Resetting 
Parameters

10-15 seconds Release the Power button when STAT LED turns 
magenta. 

Performing Factory 
Reset

30-35 seconds Release the Power button when STAT LED turns 
red. 

Emergency Power 
Off (when external 
power source is not 
connected to 
receiver)

45-70 seconds Release the Power button when all the LEDs are 
OFF.

Table 3-1. Power Button Functions and Descriptions (Continued)

Function Press Button LED Description

NOTE
A delay of several seconds occurs between the last clicking of the Power button and 
first blinking/last blinking of the REC LED.

NOTE
When using external power, the Power LED is solid green except for startup and 
shutdown procedures.

Table 3-2. LED Display

Display

LED Icon Key

SOLID BLINKING OFF



D
isplay P

anel

Receiver Status LEDs 3-3P/N: 1030371-01

Receiver Status LEDs
There are six status LEDs to provide information about satellite tracking, recording, Bluetooth, 
cellular, radio and remaining internal battery life. This section describes the color and behavior of 
each LED.

Status LED

The tracking status LED displays the status of tracked satellites when the receiver is on.

Table 3-3. Status LED Descriptions

Display LED Color Description

Green Blink One blink per tracked GPS satellite.

Yellow Blink One blink per tracked GLONASS satellite.

Cyan Blink One blink per tracked Galileo satellite.

Magenta Blink One blink per tracked BeiDou satellite.

Blue Blink One blink per tracked QZSS satellite.

White Blink One blink per tracked L-band Satellite.

Red Blink

One blink per second when there are no tracked 
satellites or solutions.
Two blinks per second when the receiver is in 
exception mode.
Otherwise, LED is dark.

Red-Green-Yellow OAF is expired.
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Recording LED 

The recording LED indicates if memory storage is being used and displays the current survey mode 
(static or kinematic) when the Occupation mode switch is selected.

Table 3-4. Recording LED Descriptions

Display LED Color Description

LED blink mode switch is selected

Green Blink File logging is in progress. Each blink indicates 
data is being written to memory. 

Blue Blink File deletion is in progress. 

Magenta Blink 
(two blinks per second) Memory storage formatting is in progress.

Magenta Blink 
(one blink per second) File system checking is in progress. 

Magenta Blink 
(one blink per two 
seconds)

File system mounting is in progress. 

Red Solid
File logging problem. No free memory or 
hardware problem with data recording.
LED is off when file is not logging data.

Occupation mode switch is selected 

Green Blink File logging is in progress. The Static mode is 
the current post-processing mode.

Yellow Bink File logging is in progress. The Kinematic mode 
is the current post-processing mode.
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Communication LEDs
The communication LEDs display the status of the wireless activity. The following tables describe the 
communication activity for two use cases: Bluetooth and Radio modems.

Bluetooth LED

The Bluetooth LED displays the status of the Bluetooth activity. Table 3-5 describes the activity. 

Red Solid
File logging problem. No free memory or 
hardware problem with data recording.
LED is off when file is not logging data.

Table 3-4. Recording LED Descriptions (Continued)

Table 3-5. Bluetooth LED Descriptions

Display LED Color Description

Blue Blink Bluetooth is on and waiting for a connection.

Blue Solid A single Bluetooth connection has been 
established.

 

Blue Solid + Blue 
Blink * N every 10 
seconds

Multiple (N) valid Bluetooth connections have 
been established.
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Cellular LED

The Cellular LED display the status of the internal cellular module. 

Table 3-6 describes the LED colors and the patterns for the cellular module.

Radio LED 

The Radio LED displays the status of the UHF modem. 

Table 3-7 describes the LED colors and patterns for the UHF modem.

Table 3-6. Cellular LED Descriptions

Display LED Color Description

No Light There is no internal cellular module or it is 
switched off

Green Solid Cellular module is on and waiting for 
connection

Green Blink The connection has been established

Table 3-7. UHF Modem LED Descriptions

Display LED Color Description

Command mode (Rover and Base)

  Red Blink - Green 
Blink - No Light

MAGNET Field or SRU sends commands to 
configure the modem.

Receiver mode (Rover)
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Green Solid Modem is not receiving correction data.

Yellow Blink Modem is receiving correction data from a base.

Transmitter mode (Base)

Green Solid Modem is not transmitting correction data.

Red Blink Modem is transmitting correction data.

Retranslator mode (Base)

 

Yellow Blink - Red 
Blink

Modem is receiving and transmitting correction 
data.

Table 3-7. UHF Modem LED Descriptions (Continued)

Display LED Color Description
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Battery LED

The battery LED indicates the remaining charge of the internal battery. When using an external power 
source, the LED turns solid green and begins to blink if the internal battery is charging. See Table 3-8 
for more information.

Table 3-8. Internal Battery LED Descriptions

Display LED Color Description

The receiver is on—and the internal battery is in use

Green Solid The charge is greater than 50%.

Yellow Solid The charge is between 10% and 50%.

Red Solid The charge is less than 10%.

The receiver is on—and the external power source in use 

Green Solid The internal battery is fully charged.

Green Blink The internal battery is at greater than 50% 
capacity; the battery is charging.

Yellow Blink The internal battery is at greater than 10% 
capacity; the battery is charging.

Red Blink The internal battery is at less than 10% 
capacity; the battery is charging.
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The receiver is off

Green Solid The receiver is connected to an external power 
source and the battery is fully charged.

Green Blink The receiver is connected to an external power 
source; the battery is charging.

No Light The receiver is not connected to an external 
power source.

Table 3-8. Internal Battery LED Descriptions (Continued)

Display LED Color Description
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Managing Power

This chapter describes how to power the receiver, charge the battery and use an external power 
source.

Turning the Receiver On/Off
To turn on the receiver, press and hold the power button until the STAT LED turns solid green. The 
receiver is turning on when: the Power LED blinks green, the receiver channels initialize and start 
tracking all visible satellites at any time and location and the serial port is available. When the startup 
is complete, the Power LED is solid green only when external power is used; otherwise the Power LED 
is off. 

After startup, the integrated wireless devices in the receiver are ready to use and the receiver is 
available to obtain the correction data from reference station and to measure ground point coordinates 
with high accuracy. Also the receiver is ready to start data recording to the internal memory.

To turn-off the receiver, press and hold the power button for more than (3 but less than 10) seconds. 
Release the power button when the Power LED blinks yellow. This delay prevents the receiver from 
being turned off by mistake. Allow the receiver to complete the power off cycle, which is approximately 
15 seconds.

Powering the Receiver
The receiver is powered by an internal battery or an external valid power source connected to the 
power port. If an external power source is connected, the receiver draws power from it instead of the 
battery. You can connect the receiver to an external power source, such as a vehicle battery, with 9 – 
27 VDC to operate the receiver. See “Specifications” on page 9-1 for more information.

See “Charging the Battery” on page 4-3 for more information.

NOTE

The receiver will draw a small amount of power from the battery when it is turned 
off. If the receiver is placed in storage for a long period, 3-6 months, the battery may 
become fully discharged. Use an external power supply or recharge the battery 
before use.

CAUTION A power input greater than 27 VDC could damage the receiver.
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Operating Hours
Table 4-1 describes the use conditions and the operating hours of the receiver. The values in the 
Approximate Hours of Operation column are obtained when using the internal battery. 

Table 4-1. GRX3 Approximate Hours of Operation

Use Condition Description
Approximate Hours of 

Operationa

a. Average with Bluetooth on and 20 Satellites tracked. Using a new, fully-charged battery, operating at room 
temperature and transmitting at 1-Hz rate.

Static Survey Static setup logging raw GNSS 
data at 1-Hz 

15 hours

SiteComm RTK 
Base

Base transmitting RTCM3 
differential corrections to one or 
multiple rovers (up to three rovers)

15 hours

SiteComm RTK 
Rover

Rover receiving RTCM3 
differential corrections over 
SiteComm connected through 
Bluetooth to a data collector 

15 hours

Network RTK 
Rover

Rover receiving RTCM3 
differential corrections from a 
Network correction service and 
connected through Bluetooth to a 
data collector 

13 hours

Network RTK 
Rover

Rover receiving RTCM3 
differential corrections from a 
Network correction service via the 
internal cell module 

12 hours

UHF Receive Only 
Mode

Rover receiving RTCM3 
differential corrections over UHF 
radio connected through 
Bluetooth to a data collector 

10 hours

UHF Transmitting 
at 0.5 W

Base transmitting RTCM3 
differential corrections at 0.5 
Watts

8 hours

UHF Transmitting 
at 1 W

Base transmitting RTCM3 
differential corrections at 1-Watt

6 hours

UHF Repeater at 
1-Watt

Receiving RTCM3 corrections and 
transmitting RTCM3 differential 
corrections at 1-Watt 

6 hours

UHF Receiver + 
SiteComm Base

Receiving RTCM3 corrections 
over UHF radio and transmitting 
RTCM3 differential corrections 
over SiteComm

10 hours
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Charging the Battery
While the battery loses charge, the BAT LED changes from solid green, to yellow and then red, 
depending on the remaining charge (see “Battery LED” on page 3-8). 

When the receiver is connected to an external power source, the internal battery is charging, 
regardless of the receiver state. 

To charge the internal battery:

1. Connect the supplied power cable to the receiver’s power port.

2. Connect the SAE connector of the power cable to the SAE connector of the power adapter.

3. Plug the power adapter into an available outlet for approximately five hours to fully charge the 
battery.

Overcharging the battery will not happen; the battery stops charging when it reaches full charge. 
During charging, the BAT LED will blink (see Table 3-8 on page 3-8).

Battery Charging Temperatures
Charge the battery only in temperatures between 32o F (0o C) and 104o F (40o C). 

An optimal charging temperature is between 50o F (10o C) and 77o F (25o C). If 
possible, charge the battery within this temperature range.

Surveying While Charging
The receiver can perform any kind of surveying while charging the internal battery without degrading 
performance.

CAUTION
Use a grounded wall outlet or grounded surge protector while charging. The 
socket should be located near the equipment and easily accessible.

40°
0°

25°
10°

CAUTION
The charge terminates automatically if battery temperature rises above 113o F 
(45o C) or falls below 32o F (0o C).

CAUTION
While charging, make sure that the air temperature is between 32o F (0o C) and 
104o F (40o C). This is important to prevent serious damage to the external power 
supply adapter, battery, and the receiver or injury to persons.
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Using an External Power Source
You can connect the receiver to an external power source (such as a vehicle battery with 9 – 27 VDC) 
to operate the receiver.

To connect the receiver to an external battery:

1. Use the ODU-to-alligator clips cable (P/N 14-008097-01LF) to directly connect the external 
battery and the receiver’s power port (without SAE).

2. Connect the ODU-to-alligator clips cable to a 12-volt battery.

3. Connect the ODU-to-alligator clips cable to the receiver’s power port.

4. Turn on the receiver.

Insufficient Power
If the battery become fully discharged and an external power supply is not connected, the receiver 
will shut down and automatically save recorded files. To avoid disruptions, check the BAT LED on the 
display panel for the battery charge status. See, “Battery LED” on page 3-8 for more information. If 
the receiver shuts down due to insufficient power, the receiver and all communication ports become 
deactivated.

To restore power to the receiver you will need to connect the receiver to an external power source:

a. Make sure the power cable is correctly connected to the power port of the receiver.

b. Align the keyways when connecting the power cable to the power port of the receiver.

c. The cable will click when it is secured in the port.

d. To remove the cable, push the cable in, then gently remove it from the power port.

CAUTION Power input greater than 27 VDC could damage the receiver.

NOTICE
Recharge the battery or connect it to an external power source using the charging 
cables and power adapter shipped with the receiver. The time to fully charge the 
battery at 77 degrees F (25 degrees C) is about 5 hours.
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Configuration

The GRX3 receiver is primarily used for surveying land and construction job sites and to support static 
and RTK applications. You can also log data internally to a non-removable SD card. These logs can be 
downloaded from the receiver for static or kinematic surveying, mapping, monitoring and positioning 
applications. The receiver uses different built-in communication technologies to transmit or receive 
RTK corrections and to achieve RTK solutions using field applications like MAGNET Field or Pocket 3D.

The receiver can be configured in a variety of ways, depending on your project requirements. Typically, 
the receiver supports the following operation modes:

● Static and kinematic post-processing

● Network RTK rover as NTRIP client 

● UHF base and rover in RTK or DGPS configuration (for receiver with UHF modem)

● SiteComm base and rover in RTK or DGPS configuration

● UHF modem repeater (for receiver with UHF modem)

● DGPS or RTK repeater

● Precise Point Positioning (PPP) rover

● SBAS rover

This chapter describes: receiver configuration, receiver options, loading a new Option Authorization 
File (OAF), updating firmware and performing a factory reset. All these actions may be performed using 
Sokkia Receiver Utility (SRU) software.

Installing Sokkia Receiver Utility (SRU)
SRU is a Microsoft Windows software application designed for configuring GNSS receivers, modem 
boards and Bluetooth modules. This software is available on Sokkia Care for registered users. After 
downloading the program from the website, copy the *.zip file into folder on hard drive of controller or 
computer.

1. Navigate to the folder and extract the SRU*.zip file.

2. Double-click SRU*.exe to run the installer and then follow the on-screen instructions.

NOTE To uninstall SRU, use Add or Remove Programs in Microsoft Windows.
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Loading New Firmware
This section of the configuration chapter describes how to update firmware on the GRX3 with a USB 
connection. To connect the receiver to your computer, use a Micro-USB cable (P/N 1013602-01) and 
USB drivers installed on the computer. USB drivers and firmware are available at Sokkia Care.

After plugging the receiver into to the computer, the operating system will report a new external 
device has been found. It will be assigned to a virtual COM port. You may check its number in the 
Windows Device Manager (Figure 5-1).

Figure 5-1: Device Manager Screen

This virtual port is used for loading new firmware. You can also update the firmware using a physical 
COM port or Bluetooth. Loading firmware using a physical COM port takes longer than using SRU. 
Therefore, Sokkia does not recommend using a physical COM port to update firmware.

Receiver board firmware is released as a file with “*.tfi” extension. Sokkia Receiver Utility version 3.6 
and higher supports loading of files with “*.tar” and “*.tfi” extensions.

To upload firmware files to the receiver, do the following:

1. Connect the receiver to a computer using a Micro-USB cable (Figure 5-2).

Figure 5-2: Micro-USB Cable Connection

2. In the Windows Device Manager, check the number of the virtual COM port.

3. Start SRU on your computer.

Sokkia GRX3 
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4. Use the Safely Remove Hardware and Eject Media feature in Windows and mount the 
receiver in SRU. For details, see “Ejecting the Receiver from Windows and Mounting in SRU” on 
page 7-8. 

5. Click Device > Application Mode > Firmware Loading, to set SRU to the firmware loading 
mode.

6. Click Device > Connect. 

The Connection Parameters screen opens.

7. Select Serial Port from the Connect Using drop down list.

8. Click the  button. 

The Select Device screen opens (Figure 5-3).

9. Select the specified COMX port for USB communication and then click OK. 

Figure 5-3: SRU—Select Device Screen

The Connection Parameters screen opens (Figure 5-4).

10. Click Connect to establish a connection with the receiver.

Figure 5-4: SRU—Connection Parameters

Sokkia GRX3

Sokkia GRX3 
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The Firmware Loading screen opens.

11. Click Firmware Loading . 

The Select Target screen opens (Figure 5-5 on page 5-4).

12. Select Receiver from the Target drop-down list (Figure 5-5 on page 5-4).

13. Click Next. 

Figure 5-5: SRU—Select Target 

The Information screen opens (Figure 5-6).
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14. Click Next. 

Figure 5-6: SRU—Device Information Screen

The Select Files screen appears (Figure 5-7 on page 5-5).

15. Click the button, browse to, and select the receiver’s *.tfi file.

16. Click Next. 

Figure 5-7: SRU—Select Files

GRX3

Sokkia

D:\FMW\GRX3\timage-b125-5.5.tfi
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The Installation screen opens (Figure 5-8). It shows the progress as the firmware uploads. 

Figure 5-8: SRU—Installation Screen

When the firmware completes uploading, a dialog window opens (Figure 5-9 on page 5-6). It 
warns not to turn off the receiver while it updates the firmware. 

17. Click OK in the dialog box.

Figure 5-9: SRU—Firmware Updating Window

SRU automatically disconnects from the receiver. The receiver reboots a few times during the 
firmware update. 

The firmware update may take up to 10 minutes. After the firmware update completes, the 
receiver returns to the normal operation mode.

NOTE
The procedure for loading new firmware into the GRX3 can be performed using 
MAGNET Field software version 5.1 and higher.
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Option Authorization Files
Sokkia’s issues an Option Authorization File (OAF) to enable the specific options that you purchased. 
Sokkia’s OAF system allows you to customize and configure the receiver according to your particular 
requirements.

The GRX3 receiver is typically shipped with an OAF based on the initial purchase of the receiver kit 
configuration. There are several upgrade options available with the receiver that can extend the 
receiver’s functionality to better suit your job requirements. Examples of upgrade options are listed 
below:

● GPS L1, L2, L5 signal tracking

● GLONASS L1, L2, L3 signal tracking

● BeiDou B1, B2 signal tracking

● QZSS L1, L2, L5 signal tracking

● SBAS L1, L5 signal tracking

● Galileo E1, E5 signal tracking

● RTK and update rate 20 Hz (10 Hz standard)

● Precise Point Positioning (PPP) Mode 

Contact your Sokkia dealer or a customer representative for a complete listing of available options 
and pricing information.

Checking the Receiver’s OAF
1. Connect the receiver to a computer and open SRU. 

2. Start SRU on your computer.

3. Click Device > Application Mode > Receiver Managing. 

4. Click Device > Connect. 

The Connection Parameters screen opens. 

5. Click the Connect button to establish a connection with the receiver.

6. Click Options  on the main screen.
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The Receiver Options window opens (Figure 5-10). Here you can view the current authorization 
options and upload new ones.

Figure 5-10: SRU—Receiver Options
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Loading an OAF
Sokkia dealers provide customers with OAF files. For any OAF related questions, e-mail Sokkia at 
options@topcon.com and include the receiver’s ID and serial number. To obtain these numbers, see 
“Getting Technical Support” on page 1-4.

1. Complete the steps in “Checking the Receiver’s OAF” on page 5-7 above.

2. Right click on the Receiver Options window and select Upload OAF (Figure 5-11).

Figure 5-11: Right-click and Select Upload OAF

3. Navigate to the location of the new Option Authorization File.

4. Select the appropriate file and click Open (Figure 5-12).

Figure 5-12: Open OAF

NOTE

SRU initially checks to see if the selected file is compatible with the currently 
connected receiver. If you chose a file that is not intended for this receiver, the 
Upload OAF window will display an error icon next to the Receiver ID (not shown) 
and disables the Upload the File to the Receiver button (Figure 5-13 on 
page 5-10).
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5. Click Upload the File to the Receiver to start loading the file (Figure 5-13).

Figure 5-13: Upload OAF to the Receiver

6. Click Yes at the prompt to reset the receiver (Figure 5-14).

Figure 5-14: Reset Receiver

The Connection Parameters screen opens.

7. Click Connect on the Connection Parameters screen. 

The SRU main screen opens.

8. Click Options . 

The Receiver Options screen opens.
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9. Check the following conditions:

● If you uploaded a universal OAF, make sure the expiration date is still valid.

● If you uploaded a customer OAF, make sure the correct customer file is loaded.

10. To view additional OAF details, right click in the Receiver Options window and select 
View > Detailed (Figure 5-15).

Figure 5-15: Additional OAF Details

NOTE
The procedure for loading new firmware into the GRX3 can be performed using 
MAGNET Field software version 5.1 and higher.
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Performing a Factory Reset
The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite 
tracking, such as ephemeris data and receiver position. The NVRAM also keeps the current receiver’s 
settings, such as active antenna input, elevation masks and recording interval and information about 
the receiver’s internal file system. A factory reset clears the receiver’s NVRAM and restores the 
receiver’s factory default settings. Factory reset takes about 1-2 minutes to perform.

Although a factory reset or clearing the NVRAM is not recommended as a common practice, there 
are times when it can eliminate communication or tracking problems.

After a factory reset, the receiver requires time to collect new ephemeris data and almanacs 
(approximately 15 minutes).

A factory reset will not delete any files already recorded in the receiver’s memory and NVRAM keeps 
information about the receiver file system.

There are two ways you can perform a factory reset—using SRU software and using the LED display 
panel.

Perform a Factory Reset Using SRU
1. Connect the receiver to a computer.

2. Start SRU on your computer. 

3. Click Device > Application Mode > Receiver Managing. 

4. Click Device > Connect. 

The Connection Parameters screen appears. 

5. Click the Connect button to establish a connection with the receiver.

6. Click Tools  on the main screen. 

The Tools screen opens (Figure 5-16 on page 5-13).
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7. Click Factory Reset. 

Figure 5-16: Tools Screen

8. Click Yes at the prompt to reset the receiver.

Figure 5-17: Reset Receiver

SRU resets the receiver and clears the NVRAM. 

Perform a Factory Reset Using the LED Display
1. Press and hold the Power button for 30–35 seconds. Release it when STAT LED turns red.

2. Wait until the STAT LED blinks yellow. 

The receiver automatically powers off. 

3. Wait until the Power LED stops blinking green. 

The receiver automatically powers on. 
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Using TILT Correction
The receiver contains the internal HIMU (Hybrid Inertial Measurement Unit) module. The module 
includes a 3D gyroscope, 3D accelerometer, and 3D magnetometer. 

GNSS firmware of the GRX3 contains the ELC (Electronic Level and Compass) program module. This 
module uses the measured parameters from the HIMU, receiver navigation coordinates from the 
GNSS firmware and magnetic field map for calculation of tilt angles in the horizontal plane, and true 
(not magnetic) azimuth and magnetic field values. Using these data, GRX3 solves the following tasks:

1. It calculates the tilt angle of the pole and transmits the value to the field software. The software 
will calculate the true coordinate of the measured ground point. You can activate this mode 
using MAGNET Field (version 5.1 and higher). For the Topo, Autotopo, and Stake survey, 
MAGNET Field uses the tilt angle of the pole from the ELC module to calculate the offset of the 
GNSS antenna phase center in the horizontal plane, for each GNSS epoch. These offset values 
are used for obtaining the true coordinates of the measured ground point. This mode will work if 
the current tilt angle does not exceed the threshold value. A user can specify this value in the 
range from 1 to 15 degrees.

Figure 5-18: Tilt Correction Mode

1. Tilt pole angle 3. Offset dN/dE

2. False projection of the 
phase center

4. True projection of the 
phase center

1124

1

3
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2. It automatically starts the measuring of a point if the pole tilt value is less than 1 degree during 
the time interval longer than the specified value. 

3. It shows/hides a graphic view of the bubble level. MAGNET Field shows the bubble level in the 
Topo, Autotopo, and Stake dialogs for GNSS configuration only.

Figure 5-19: Bubble Level

4. Shows/hides the value of the external magnetic field in the graphic and text view in the Topo, 
Autotopo, and Stake mode.

HIMU Calibration
The internal HIMU provides 3-axis monitoring of the earth's magnetic field to deliver azimuth data. 
Due to e-compass parameters used in this technology, a simple field calibration procedure is 
required. Using MAGNET Field or SRU, you can perform the electronic level and the compass 
calibration procedure.

The calibration consists of the following procedures:

1. Electronic level calibration (see “Level Calibration” on page 5-16)

2. Magnetic compass calibration in 3D (see “3D Compass Calibration” on page 5-17)

3. Magnetic compass calibration in the horizontal plane (see “Horizontal Plane Compass 
Calibration” on page 5-18)

Perform each calibration procedure independently and sequentially. When all three calibrations are 
finished, the HIMU is ready to use.

Follow these general recommendations when performing the ELC calibration: 

● Perform the calibration in the field, after that the receiver tracks the satellites and determines a 
position.

● Establish the connection with a controller via Bluetooth or Wi-Fi. 

● Turn on and/or connect all equipment that will be used for the survey, before calibrating. 

● For RTK survey, use your choice of modem to receive the corrections data and obtain the Fixed 
solution.

● If using the UHF modem, connect the radio antenna and turn on the radio modem. 

● Do not use an external power source.

You can use MAGNET Field or SRU to calibrate the ELC module of the GRX3 receiver. 
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Level Calibration

To take an accurate level and compass reading, first you need to perform the electronic level 
calibration procedure. 

Do the following:

1. Set up the receiver on a tripod with a universal tribrach and tribrach adapter: 

● Level the tribrach.

● Set the receiver on a tribrach adapter with a 100 mm aluminum prism spacer.

● Eliminate any vibrations during the calibration.

Figure 5-20: Receiver and Tribrach Set Up

The receiver tracks satellites and determines a position. 

2. In MAGNET Field/SRU, click Calibrate in the Level field. 

The calibration process starts. It takes about 30 seconds to complete. 

● If the calibration succeeds, the Level field shows the date and time for the new calibration. 

● If the calibration fails, the Level field shows the date and time for the previous successful 

calibration with the  icon.

1. GRX3 3. Rotating tribrach adapter

2. 100 mm prism spacer 4. Tribrach

1

2

3
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3D Compass Calibration

To take an accurate compass reading, first you need to perform the compass calibration procedure 
for each location in 3D, before starting a survey. 

Do the following: 

1. Hold the receiver flat with the GNSS antenna randomly pointed up. 

2. Press the Calibrate Compass button. 

3. Rotate the receiver 360 degrees in multiple planes and directions. The position of the receiver’s 
antenna’s phase center should fill an entire sphere around the receiver.

MAGNET Field/SRU shows a progress bar reflecting your progress with filling the sphere around 
the receiver. It shows, “Compass is being calibrated,” (Figure 5-21).

Figure 5-21: Calibrating the Compass in 3D

● If you have successfully filled the entire sphere, MAGNET Field/SRU shows, “Calibration has 
completed,” (Figure 5-21). 

The calibration parameters are saved. The receiver’s compass is ready to use. 

● If you stop rotating the receiver before the calibration procedure is complete, after two 
minutes of leaving the receiver still, without movement, MAGNET Field/SRU shows, 
“Calibration has failed.” 

Perform the procedure again until you have successfully filled the entire sphere. 

NOTICE
Be sure to calibrate the level (see “Level Calibration” on page 5-16), before 
calibrating the compass.

1. Compass being calibrated 3. Compass being calibrated

2. Compass being calibrated 4. Calibration has completed

1 2 3 4

NOTE
The calibration is saved when you turn the receiver power off. The saved 
calibration is used the next time you turn the receiver power on. 
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Horizontal Plane Compass Calibration

To take an accurate compass reading, you need to perform the compass calibration procedure in the 
2D, horizontal plane for each location, before starting a survey. 

Do the following: 

1. Set up the receiver on a tripod with a universal tribrach and tribrach adapter: 

● Level the tribrach.

● Set the receiver on a tribrach adapter with a 100 mm aluminum prism spacer.

● Set the receiver at a 90-degree angle to the horizontal plane to maximize the accuracy of the 
calibration. 

● Eliminate any vibrations during the calibration. 

Figure 5-22: Receiver and Tribrach Set Up

The receiver tracks satellites and determines a position. 

2. In MAGNET Field/SRU, click Calibrate in the Level field. 

3. Turn the receiver clockwise in the horizontal plane. 

MAGNET Field/SRU shows a progress bar reflecting how many turns are left to complete the 
calibration. 

NOTICE
Be sure to calibrate the level first (see “Level Calibration” on page 5-16), 
then calibrate the compass in 3D next (see “3D Compass Calibration” on 
page 5-17), before calibrating the compass in the 2D, horizontal plane.

1. GRX3 3. Rotating tribrach adapter

2. 100 mm prism spacer 4. Tribrach

1

2

3

4
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● If you do not make any turns for two minutes, the calibration routine automatically stops.

Perform the procedure again until you have successfully filled the entire sphere.

● If you successfully complete all of the turns, MAGNET Field/SRU shows, “Calibration has 
completed.” 

The calibration parameters are saved. The receiver is ready to use. 

● If you do not successfully complete all of the turns, MAGNET Field/SRU shows, “Calibration 
has failed.” 

Perform the procedure again until you have successfully filled the entire sphere. 

When Compass Recalibration is Required

During operation, the receiver evaluates the local magnetic environment and alerts a user if a 
recalibration is required. These alerts appear in the field software. Make sure to recalibrate the 
receiver when the field software indicates. Also recalibrate the receiver under the following 
conditions:

● If the receiver has been off for a long time 

● If the receiver is used for the first time 

● If the survey location changes frequently 

● If the receiver took a shock, such as being dropped 

● If temperature changes are 10 degrees or more 

● If the receiver was transported by a car or airplane 

● If the receiver was near a strong magnetic object or material, such as a permanent magnet, 
electromagnet, electric transformer, AC power supply, and so forth 

● After loading new firmware 

● After clearing the NVRAM 

NOTE
The calibration is saved when you turn the receiver power off. The saved 
calibration is used the next time you turn the receiver power on. 
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System Setup

The base receiver transmits RTK corrections to the rover receiver using either SiteComm wireless 
technology or UHF modem. The internal cell module receives correction data from reference GNSS 
networks.

This chapter describes the field setup for base or RTK rover usage.

Setting Up the Base Receiver
1. Install a heavy-duty tripod (P/N 22-050501-01) over a known point (Figure 6-1). 

Figure 6-1: Setting Up Base Receiver

2. Position the base receiver over a point with a known coordinate in the current coordinate system.

NOTE
You do not need a universal tribrach and tribrach adapter when working on this 
tripod.
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3. Attach the antenna to the UHF modem antenna connector.

4. Level the tripod and tighten the screws.

5. If needed, attach any other accessories, such as a back-up power supply.

6. Measure the height of the receiver from the ground using the tape measure. See “Measuring 
Antenna Height”.

7. Press the Power button to turn on the receiver. The integrated wireless device inside the receiver 
turns on when the receiver is powered.

8. Run MAGNET Field software on the field controller and connect the base receiver to the 
controller via Serial Port or Bluetooth. Select the following parameters: 

● Elevation mask 

● The RTK output format 

● Radio modem parameters (for UHF modem; Power, Protocol, Modulation, Spacing, 
Scrambling 

● FEC for UHF modem; Power, Channel, Protocol) 

● Raw data logging, if it is required

9. Use MAGNET Field software:

● Type in the name of the point where the Base receiver is located.

● Enter the coordinates of this point.

● Click the Start Base button to start the receiver as the Base transmitting the correction data.

10. View the LED display panel for the receiver’s current status. See “System Setup” on page 6-1 
for more information about LEDs.

NOTE
Select RTCM MSM3 format in the RTK output protocol to create the correction data 
with measurements of GPS, GLONASS, BeiDou, Galileo, QZSS, and NavIC satellite 
systems.
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Setting Up the Rover Receiver
1.  Attach the receiver to the pole. Make sure the receiver locks into place.

Figure 6-2: Rover Receiver

2. If you are not using a fixed height rover pole, measure the height of the receiver from the ground. 
See “Measuring Antenna Height” on page 6-6.

3. Attach the antenna to the UHF modem antenna connector if you are using a radio modem. If 
necessary, see “Receiver Enclosure Bottom—Connectors” on page 2-11.

4. If you are using a cellular module insert the SIM card into the SIM card slot. If necessary, see 
“Receiver Enclosure Bottom—Connectors” on page 2-11.

5. Press the Power button to turn on the receiver. The integrated wireless device inside the receiver 
turns on when the receiver is powered.

6. Run MAGNET Field software on the field controller and connect the rover receiver to the 
controller via Serial Port or Bluetooth.

7. Configure UHF modems or cellular modules:

● Select for the receiver with the UHF or FH modems:

○ An elevation mask 

○ The RTK input format 

○ The radio modem parameters (for UHF modem; Power, Protocol, Modulation, Spacing, 
Scrambling, Channel, FEC) 

○ The parameters of raw data logging, if it is required 

NOTICE
If you are using a cellular module in Network RTK configuration, ensure that the 
cellular antenna is attached to the GRX3 receiver.
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● Select for the receiver with the cell module:

○ The type of correction data that will be used for survey (VRS or Single Base or MAGNET 
Relay)

○ The protocol of the input correction data: TCP/IP or NTRIP 2.0/1.0 or NTRIP 1.0

○ An elevation mask

○ The RTK output format

○ The Internet address and TCP port number of the remote server, a password and user ID 
to login to the selected server and configure parameters for a dial-up Internet connection 

○ The parameters of raw data logging, if it is required 

8. Click Connect icon on the main screen of the MAGNET Field and click the Connect button in 
the Connections screen to establish Internet connection to the remote server and obtain the 
correction data from it. 

9. View the LED display panel for the receiver’s current status. See “Display Panel” on page 3-1 for 
more information about LEDs.
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Using GRX3 with External Antenna
The GRX3 GNSS receiver can be used with an external antenna. The GRX3 receiver is primary 
designed for using with Sokkia active (with LNA) external antenna.  

To work with an external GNSS antenna you have to manually set the external antenna type using 
MAGNET Field or SRU application. 

● Using MAGNET Field:

a. Select Configure > Application Mode. 

b. Open the Config: Base Receiver or Config: Rover Receiver dialog.

By default, the internal antenna of GRX3 is set for this receiver;

Figure 6-3: Configuration GRX3 with Internal Antenna in MAGNET Field

c. From the Antenna drop-down list, select a type of the base/rover receiver antenna used. 

Figure 6-4: Configuration GRX3 with External Antenna in MAGNET Field

d. Click  to save changes in the configuration wizard.

CAUTION
Sokkia cannot guarantee the correct performance with other brands of GNSS 
antenna. Do not use passive GNSS antenna with the GRX3 receiver.
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e. Connect the external antenna to the External GNSS Antenna Connector using the External 
Antenna Cable (P/N 1006447-01). 

● Using SRU:

a. Select Receiver SettingsTracking and Positioning.

In the Antenna tab, the internal antenna of GRX3 is set for this receiver by default;

Figure 6-5: Configuration GRX3 with Internal Antenna in SRU

b. Select the External radio button to activate an external type for GRX3 receiver. Click OK 
button to sent this change to the receiver: 

Figure 6-6: Configuration GRX3 with External Antenna in SRU

c. Connect the external antenna to the External GNSS Antenna Connector using the External 
Antenna Cable (P/N 1006447-01).

When the external antenna is selected, the GRX3 supplies a voltage in the range from +4.5 V to +5.5 
V to the central pin of the SMB antenna connector. Maximum antenna current equals to 120 mA.

Measuring Antenna Height
The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates 
of the station marker, specify the following:

● Measured height of the antenna above the station marker

● Method of measuring the antenna height

NOTE After this change the receiver will track GNSS signals only with external antenna.

NOTE After this change the receiver will track GNSS signals only with external antenna.
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● Model of the antenna/receiver used

Any necessary antenna phase center adjustments, based on the antenna model, are automatically 
applied. These adjustments, when combined with accurately measured height and measurement 
methods, allow for correctly computed reference marker coordinates.

To accurately measure the antenna height, do the following:

1. Orient the receiver with the display panel facing north. 

2. Measure the antenna height above the control point or marker, either the slant height or the 
vertical height. You may either: 

● Measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of the 
receiver at the base of the mounting threads. 

● Measure the slant height to the Slant Height Measurement Mark (SHMM) on the side of the 
receiver. 

3. Record the antenna height, points name and start time in the field notes. 

Figure 6-7: Antenna Height Measurement Points

1. C1—Slant offset 7. A1—Vertical offset

2. C2—Slant offset 8. A2—Vertical offset

3. SHMM—Slant Height Measurement Mark 9. Orient to north

4. R—Radius of measurement point 10. ARP—Antenna Reference Point

5. L1—Phase center 11. Vertical height

6. L2—Phase center 12. Slant height
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Collecting Data

This chapter provides general information about memory, recording data, downloading data and 
removing files to free up memory space.

Memory
The GRX3 is equipped with an internal 8 GB memory card. The memory card is formatted as FAT32. 
To access the raw, "*.tps" data files on the memory card, see “Managing Files” on page 7-5.

Setting Recording Parameters
You can use one of the following ways to set logging parameters, such as logging rate, types of 
messages and so forth.

● Sokkia Receiver Utility (SRU) software

● MAGNET Field software

Logging Rates
Memory usage for data logging depends on the logging rate. For more information about setting 
logging rate parameters, see the SRU Online Help.

Recording Data
You can log GNSS Raw data to the receiver’s memory card and use the Sokkia Receiver Utility (SRU) 
or MAGNET Office to download the files to a computer.

Recording Data via the LED Display Panel
To start recording data, using the LED display panel:

1. Press the Power button to turn on the receiver.

2. Wait for the Power LED to stop blinking green. 

The receiver is now available to log the raw data.

3. Press the Power button three times in a row within 2 seconds to start recording.

4. Make sure the REC light blinks green, which indicates a “*.tps” data file has opened and data 
collection has started. 

The REC LED blinks each time data is saved to the internal memory. If the REC light blinks red, 
the receiver has either a hardware problem or an improper OAF. See “Option Authorization Files” 
on page 5-7 for more information.

NOTE
The receiver is not available to log the raw data until the startup procedure is 
completed.
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Stopping Data Recording via the LED Display Panel

To stop recording press the Power button three times in a row within 2 seconds and make sure that 
the REC LED is dark.

Recording Data Using Sokkia Receiver Utility (SRU)
To start recording data using Sokkia Receiver Utility (SRU):

1. Press the Power button to turn on the receiver.

2. Wait for the Power LED to stop blinking green.

3. Do one of the following procedures: 

■ If the receiver is connected by a USB connection, use the Safely Remove Hardware and Eject 
Media feature in Windows and mount the receiver in SRU. For details, see “Ejecting the 
Receiver from Windows and Mounting in SRU” on page 7-8. 

■ If the receiver is connected by a Serial/COM connection, continue to Step 4.

4. Launch SRU and establish the connection with the receiver in the Receiver Managing mode. 
Refer to the SRU Help for more information.

5. Click the File Explorer icon. 

The File Explorer screen opens (Figure 7-1).

6. Click to open the Logs tab. 

You can record up to 16 raw, "*.tps" data files simultaneously, from A to P. For each file you can 
use the its own default settings for logging.

Figure 7-1: Logs Tab of the File Explorer Screen

7. Right click on the desired file to open the context menu.

NOTE With the Power button, you can record up to 16 raw, "*.tps" data files.
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8. Select Edit to open the Log screen and specify individual settings such as Elevation Mask, 
Prefix and Rotation Period.

To use these log parameters after pressing the MINTER, select Use for MINTER & AFRM 
(Figure 7-2).

Figure 7-2: Context Menu of Logs Tab

9. Click OK to save all changes.

10. Using the MINTER, you can start logging one or more files: 

■ By default, clicking the Power button three times in a row within two seconds will log a file. 
This file is called File A (Figure 7-4 on page 7-4). 

■ By default, the Use for MINTER & AFRM check box is enabled only for File A. You can select 
this check box for any number of files. In this case, clicking the Power button will 
simultaneously start those files for which the Use for MINTER & AFRM check box is enabled. 

The current logging files are displayed on the Logs tab (Figure 7-3).

Figure 7-3: Logs Tab with Logging Files
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Recording Data with Default Settings

To start recording data to the selected file with default settings do the following.

1. Right click on the desired file to open the context menu.

2. Select Start File Logging (Default Settings). 

The currently logging file shows in the Logs tab (Figure 7-4).

Figure 7-4: Start File Logging With Default Settings

Recording Data with Manual Settings

You can specify the logging parameters manually. To start recording data to the selected file with 
manual settings, do the following.

1. Right click on the desired file to open the context menu.

2. Select Start File Logging (Manual Settings). 

The Start Logging dialog window opens.

Figure 7-5: Start Logging Dialog Window

3. Specify the file name and logging period.

4. Click OK to start logging the file using the entered parameters. 

The current logging file shows in the Logs tab (Figure 7-6).



C
ollecting D

ata

Managing Files 7-5P/N: 1030371-01

Figure 7-6: File Logging With Manual Settings

Stopping Data Recording

To stop recording data, do the following.

1. Right click on the desired file to open the context menu.

2. Select Stop File Logging. 

The Files tab of File Explorer screen displays the list of raw, "*.tps" data files stored in the 
receiver memory.

Managing Files
The receiver records "*.tps" data files to a storage medium with a FAT32 file system. The files and 
folders are organized in a hierarchical structure. A total of 4000 files can be recorded and stored on 
the storage medium. 

You can program the receiver to:

● Record "*.tps" data files up to a maximum of 16 simultaneous files. Each file can be logged with 
its own parameters.

● Close the current log file and open a new one according to a user-defined schedule. This option 
is called Automatic File Rotation Mode (AFRM).

● Automatically remove the oldest files to make room for the new files, using storage quotas on the 
existing files.

● Automatically upload files to an FTP server.

USB Connection Specifics
After establishing a connection between the GRX3 receiver and a computer or controller using a USB 
cable:

● The GRX3 receiver is ready to upload and download files between the receiver’s memory and the 
controller or computer’s storage.

Windows Explorer shows the receiver’s memory storage as a USB drive with the GRX3 folder.

NOTE
You can also log data using MAGNET Field software. With MAGNET Field, you can 
record only one raw, "*.tps" data file at time.
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Figure 7-7: GRX3 USB Folder in Windows Explorer

 

Figure 7-8: GRX3 S/N in Windows Explorer

You can use Windows Explorer to upload and download files to and from the GRX3 receiver.

● The GRX3 receiver is not ready to record "*.tps" data files to memory storage. SRU can not 
access the memory storage or update the firmware. 

You can not start logging a "*.tps" data file.

Figure 7-9: SRU File Explorer—Start File Logging Unavailable

You can not access the "*.tps" data files stored in the receiver’s memory.

NOTE
If the GRX3 storage memory was formatted using SRU, the device name of 
the receiver will show as receiver_serial_number-I, where “I” indicates 
that this is the internal storage memory (Figure 7-8). 
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Figure 7-10: SRU File Explorer—File System Not Mounted

You can not update the firmware. If you try to update the firmware, the error message in 
Figure 7-11 shows.

Figure 7-11: SRU—Not Enough Flash Memory Error

● The GRX3 receiver is ready for configuration of other receiver settings. 
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Ejecting the Receiver from Windows and Mounting in SRU

When the GRX3 receiver is connected by USB, use the Safely Remove Hardware and Eject Media 
feature in Windows to prepare the receiver for any of the following tasks: 

● Recording "*.tps" data files to memory storage 

● Accessing the memory storage using SRU 

● Updating the firmware using SRU 

Do the following on the controller or computer. 

1. Use one of the following two procedures: 

■ From the Windows taskbar: 

a. Right click the Safely Remove Hardware and Eject Media feature in the notification 
area on the lower right of the screen.

b. Select Eject USB Drive for the GRX3 from the menu.

Figure 7-12: Safely Remove Hardware—Eject USB Drive

The Safe To Remove Hardware window opens (Figure 7-13). Do not disconnect the USB 
cable from the receiver and the controller or computer.

Figure 7-13: Safe To Remove Hardware

■ From Windows File Explorer: 

a. Right click the device name of the receiver. This may appear as the receiver’s serial 
number. 

b. Select Eject from the menu.
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Figure 7-14: Eject Device

The device name of the receiver is removed from Windows File Explorer. The computer 
or controller is no longer using the USB connection to the receiver. 

2. In SRU, click Device > Application Mode > Receiver Managing.

Receiver Managing Mode is selected. 

3. Click Device > Connect. 

The Initializing Connection window shows briefly.

4. Click File Explorer. 

The SRU File Explorer screen opens. 

5. Click Files. 

The Files tab window opens. It shows, “File system not mounted.”

6. Right click  to select the internal memory. 

7. Select Mount > Mount from the menu and click OK.

Figure 7-15: Mount Flash Memory

The Files tab window shows “Initializing,” then populates the internal memory information (File 
System Info, Status, and etc.). 

8. Click to open the Logs tab. 

The GRX3 is ready to record "*.tps" data files to memory storage. SRU can access files in the 
memory storage.
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Downloading Data Files Using SRU
When a survey is completed, you can download "*.tps" data files to a computer for storage, post-
processing or backup. To download raw, "*.tps" data files from the receiver to a computer, do the 
following.

1. Select the Files tab on the File Explorer screen. 

The Files tab displays the list of raw, "*.tps" data files stored in the receiver memory. 

2. Right click on the desired file(s) to open the context menu and select Download.

Figure 7-16: Selecting to Download Files

3. Select the folder where the "*.tps" data file(s) will be saved. Click OK.

Figure 7-17: Browse For Folder

SRU starts downloading the selected file(s) to the folder.
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Figure 7-18: Downloading "*.tps" data file(s) to Computer

Deleting Data Files from the Receiver Memory Using SRU
When the memory is full, the receiver stops logging data and the REC LED turns dark/off, indicating 
an error condition. Existing data are not overwritten.

To delete raw, "*.tps" data files from the internal memory of receiver do the following:

1. Right click on the desired file(s) to open the context menu and select Delete. 

2. Click Yes to confirm, then click OK.

SRU starts deleting the selected file(s) from the receiver memory. 



Check This First P/N: 1030371-01 8-1

Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the 
receiver.

Check This First
Before contacting your local dealer or Sokkia Technical Support, check the following:

● Check all external receiver connections carefully to ensure correct and secure connections. Double 
check for worn or defective cables.

● Check the receiver’s internal battery for a full charge.

● Check the power source for incorrectly connected cables and ensure the power source is valid. 
See “Cellular Module RF Connector” on page 9-9 for external power requirements.

● Check the software. Make sure the most current software version is downloaded onto the 
computer and the most current firmware is loaded into the receiver. Check the Sokkia Care website 
for the latest updates.

● Check Sokkia Care (https://us.sokkia.com/sokkia-care) for the latest updates.

Then, try the following:

● Power on and off the receiver by pressing the Power button or by using SRU (Tools > Reset 
receiver).

● Restore default settings by clearing the NVRAM. See “Perform a Factory Reset Using the LED 
Display” on page 5-13. This restores the receiver’s parameters to the factory default settings and 
erases the almanac and ephemeris files. This action does not delete data files from the receiver 
memory.

If the problem persists, see the following sections for other solutions.

Powering Problems
The following are some of the most commonly encountered power problems.

The Receiver Does Not Power Up

The battery may be discharged.

○ Charge the battery overnight. See “Charging the Battery” on page 4-3.

● If you are using an external power source, the cable may be disconnected or damaged.

○ Make sure that the cable is securely connected and undamaged.

● The receiver may have a defective charger or defective battery.

CAUTION
Do not attempt to repair equipment yourself. Doing so will void the warranty and 
may damage the hardware.

https://us.sokkia.com/sokkia-care
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○ If, after changing the battery or connecting an external power source, the receiver still 
does not power up, contact your local dealer or Sokkia Technical Support for advice.

If the internal battery is charged, reset the hardware using the Hardware Reset button. See “Receiver 
Enclosure—Bottom Overview Labels” on page 2-5.

Receiver Problems
The following are some of the most commonly encountered receiver problems.

The Receiver Cannot Establish a Connection to a Computer or External Controller

Cable specific problems:

● The cable is not properly plugged in.

○ Unplug the cable, then securely and properly reconnect it to the receiver.

● The cable is damaged.

○ Use an undamaged cable. Contact a dealer to replace the cable.

● The cable is connected to a computer running Windows 7 and the USB driver is not installed.

○ If you are using a USB cable connection with a computer running Windows 7, make sure 
the USB driver is installed on the computer. You can download the driver from Sokkia 
Care at: https://us.sokkia.com/sokkia-care-products/grx3-gnss-receiver.

Generic problems:

● The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open SRU (see “Connection” in the Sokkia Receiver 
Utility (SRU) Help embedded in the software).

b. Click Receiver Settings > Ports.

c. Change the Input Mode for the port used for connection to cmd.

The receiver does not lock on to satellites for a long period of time

● The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be 
on to track satellites).

○ Order a new OAF with the desired options activated to enable or extend validity of the 
corresponding receiver options. Contact a dealer or visit the Sokkia website for details.

○ Refer to the “Receiver Managing” chapter of the Sokkia Receiver Utility (SRU) Help for a 
detailed description of options.

The receiver tracks too few satellites

● If the survey is conducted near obstructions (tree canopy, tall buildings and so forth).

○ Make sure that the Multipath Reduction boxes have been enabled in the field data 
collection software.

https://us.sokkia.com/sokkia-care-products/grx3-gnss-receiver
https://us.sokkia.com/sokkia-care-products/grx3-gnss-receiver
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a. Connect the receiver to a computer and open SRU (see “Connection” in the Sokkia Receiver 
Utility (SRU) Help embedded in the software).

b. In SRU, connect to the receiver.

c. On the SRU main screen, choose Receiver Settings > Tracking > Adv tab. Make sure the 
C/A code multipath reduction check box is selected.

● Move to an area free of obstructions, if possible.

The receiver cannot obtain Code Differential and/or RTK solutions

● Incorrect Base coordinates entered.

○ Specify the correct coordinates for the Base station using SRU or another suitable field 
data collection software.

○ There could be some obstruction to the connection.

○ Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to 
the Rover.

● The corresponding receiver options may be disabled or expired.

○ Order a new OAF with the required options activated to enable or extend validity of the 
corresponding receiver options. 

○ Refer to the Sokkia Receiver Utility (SRU) Help for a detailed description of options.

● There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover 
should track at least five common satellites.

○ Check the elevation masks of the Rover and Base receivers; they should be the same. To 
do this, on the SRU main window, choose Receiver Setting > Tracking > Obs.

○ Verify there is a clear view of the sky to allow sufficient satellite tracking.

● A discrepancy exists between the differential standards used at the Base and Rover receivers.

○ Ensure the Base and Rover receivers use the same corrections input/output format:

a) Connect the receiver to a computer and open SRU (see “Connection” in the 
Sokkia Receiver Utility (SRU) Help embedded in the software).

b) In SRU, connect to the receiver.

c) On the SRU main window, choose Receiver Settings > Ports.

d) Double-click on the port to be configured and make sure the input mode of the 
Rover matches the format of the Base output mode (i.e. RTCM3). 

● Poor satellite geometry (PDOP/GDOP values are too high).

○ Conduct the survey where satellite visibility is better (low PDOP value).

○ Ensure the elevation mask is less than 10 degrees.
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○ Increase the PDOP threshold. To do this, on the SRU main window, choose Receiver 
Settings > Tracking > Obs.

● The elevation mask is above 10 degrees.

○ Lower the elevation mask. To do this, on the SRU main window, choose 
Receiver Settings > Tracking > Obs.

○ Verify there is a clear view of the sky to allow sufficient satellite tracking.

● The modem battery is low.

● The specified baud rate is incompatible with the baud rates the modem supports. The baud rate 
is the rate at which the receiver transmits differential messages to the modem and vice versa.

○ Change the modem’s baud rate.

● The Base and Rover modems use different radio link parameters.

○ Configure the Base and Rover radio modems according to the procedures listed in the 
SRU Help.

● The distance between the Base and Rover is too far.

○ Close the distance between the Base and Rover.

○ Use repeaters to increase radio coverage.

● There may be a source of radio interference that disrupts radio communications.

○ Change the RF channel (if possible).

○ Removing the source of the jamming signal or relocate the radio antennas (if possible).

The receiver does not start logging data

● The receiver’s memory is disabled or expired.

○ Make sure the memory option is enabled. For details, see the Sokkia Receiver Utility 
(SRU) Help.

● The internal memory does not have free space.

○ Download and/or delete data files to free up space for new files. See “Downloading Data 
Files Using SRU” on page 7-10.

○ The file system is not initialized. Initialize the File System on the internal memory using 
SRU. To do this, on the SRU main screen, choose File Explorer > Initialize File System.
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Bluetooth Problems
The following are some of the most commonly encountered error messages and other problems.

SRU error message: Cannot find receiver

● The receiver is turned off.

○ Ensure the receiver has power and is turned on.

● Bluetooth is not turned on; the BT LED is off.

○ Reset the receiver to the factory default settings by pressing the Power button for 10 to 
15 seconds.

○ You can also turn on power to Bluetooth using SRU. To do this, on the SRU main 
window, choose Receiver Settings > Bluetooth.

● There is interference.

○ Move the receiver, controller or computer to an unobstructed location.

● The receiver is too far away.

○ Move the devices closer together.

● The receiver is already connected via Bluetooth to another device.

○ Disconnect the receiver from the other controller or computer.

● The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open SRU (see “Connection” in the Sokkia Receiver 
Utility (SRU) Help embedded in the software).

b. Click Configuration > Receiver > Ports.

c. Change the Input Mode for the Bluetooth serial port used for connection to cmd.

SRU error message: Open COM# port failed: Access is denied.

● Another application uses the computer port dedicated for connection.

○ Close the application and then re-connect.

○ Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

● The receiver is not receiving power.

○ Check that the receiver is getting power and is turned on.

NOTE
This is the most common cause for this error message. Use SRU to double check 
the settings for the connection port.
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○ Check that the power cable is correctly attached to the port if one is being used.

○ Unplug the cable, then securely and properly reconnect it to the receiver.

○ If the power cable is damaged, contact a Dealer to purchase a new cable.

You Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot 
connect to it

● Device security settings probably differ.

○ Make sure the Bluetooth enabled devices use the same security settings.

● Bluetooth module settings may have changed.

a. If the settings are changed for the Bluetooth module, remove it from the list of discovered 
Bluetooth devices using the Bluetooth manager program (supplied with the device used to 
manage the receiver).

b. Repeat the search.

SRU Problems
The following is the most commonly encountered SRU problem.

SRU cannot connect to the receiver

● The receiver is turned off.

○ Ensure the receiver has power and is turned on.

● If using a cable, the cable’s connectors are improperly attached.

○ Check that the cable connector is attached to the correct serial port. 

○ Unplug the cable, then securely and properly reconnect it to the receiver.

● If using a cable, the cable is damaged.

○ Use an undamaged cable.

○ Contact a dealer to purchase a new cable.

● If using Bluetooth wireless technology, the incorrect port is selected.

○ Use a computer or receiver that has Bluetooth wireless technology enabled/installed.

○ Make sure the computer and receiver use the correct ports for communication—For the 
GRX3 receiver, this is Bluetooth serial port A (btsp\a).

SRU error message: Not enough flash memory is available. To update the firmware using 
selected firmware image format, there must be a properly formatted flash card in the receiver, 
which has enough free space to allocate the firmware file.

● Use the Safely Remove Hardware and Eject Media feature in Windows and mount the receiver 
in SRU. For details, see “Ejecting the Receiver from Windows and Mounting in SRU” on page 7-8. 
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Cleaning and Storing the Receiver
● Use a clean cloth moistened with neutral detergent or water.

● Never use an abrasive cleaner, ether, thinner benzene or other solvents.

● Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, 
clean cloth.

Getting Customer Support
If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact your 
local Sokkia dealer or visit Sokkia Care (https://us.sokkia.com/sokkia-care) for technical support. For 
contact information, see “Getting Technical Support” on page 1-4.

https://www.topconpositioning.com/support
https://us.sokkia.com/sokkia-care
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Specifications

This chapter describes the internal component specifications for the GRX3.

General Details
Table 9-1 lists the receiver’s general specifications.

Table 9-1. General Receiver Specifications

Item Specification

Physical

Enclosure Magnesium Alloy housing

Color Sokkia Gray/Blue bumper

Dimensions (mm) 149 (w) x 149 (l) x 94.6 (h)

Weight (kg) 1.061 

Internal GNSS Antenna Internal integrated Full wave Fence Antenna Technology with 
internal ground plane 

External GNSS Antenna (available only in non-cellular receivers)
Connector: SMB
Nominal impedance: 50 Ohm
LNA power: +4.5 to 5.5 @ 0-120 mA
Over current protection values: 
minimum: 102 mA, 
typical: 115 mA, 
maximum: 140 mA

External Cellular Antenna Connector: SMA
Signal type: GSM/LTE
(available only in integrated cellular receivers) 

Battery Internal battery contains two Lithium-ion internal battery packs. 
Each pack is 3.6 V, 6.96 Ah, 25.1 Watts

Seals Silicon (molding in color)

Key 1 Power Key – On/Off and Start/Stop Data Logging

LEDs 7 status LEDs:

● Power

● STAT

● REC

● Bluetooth

● Cellular

● Radio

● BATT 
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Port, Bus and Connectors 1 Port:

● Serial
1 Bus

● USB Serial

3 Connectors

● Power

● External GNSS antenna or external cellular antenna

● External Radio antenna

Environment

Operating Temperature ● -20°C to +50°C (Battery power/Non-charging)

● 0°C to +40°C (External power supply/Battery charging)

● -40°C to +65°C per MIL-STD 810G

Storage Temperature -40°C to +85°C

Humidity 100%

Ingress Protection Dust and water ingress protected (IP67)

Vibration Random: MIL-STD 202G, Method 214A
Mechanical: Compliance with MIL-STD 810G - 516.6

Drop Survive 2 meter pole drop onto concrete surface
Survive 1 meter handle drop

Power

Battery Internal: two Lithium-ion battery packs, 3.6 V 
Total capacity: 13.2 Ah, 50.2 Watts

Operating Time

Average with modem “on” 
and 20 SVs tracked.

Using new, fully-charged 
battery, operating at room 
temperature and transmitting 
at 1-Hz rate.

For the GRX3 with R2 Lite UHF Modem:

● Receive-only mode – 10 hours 

● Transmitting at 0.5 W – 8 hours

● Transmitting at 1 W – 6 hours
For the GRX3 without a Modem:

● Modem off – 15 hours
For the GRX3 with R2 Lite UHF and 4G/LTE

● UHF, Receive-only UHF mode – 10 hours

● UHF, Transmitting at 0.5 Watts – 8 hours

● UHF, Transmitting at 1 Watt – 6 hours

● LTE/Cellular, Receive-only mode – 12 hours

External Power Connector ODU-5

Input Voltage 9 – 27 VDC

Battery Charge Connect external power to charge internal battery.

Table 9-1. General Receiver Specifications (Continued)

Item Specification
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Charging Time Approximate – 5 hours for full charge using manufacturer-
supplied battery charging cradle (P/N 1010975-02) and adapter 
(P/N 1005556-01).

On-board Backup battery for timekeeping and almanac data storage; 
minimum 10 years of operation

GNSS Receiver Board Details

Number of Channels 226 GNSS channels Vanguard Technology™ with Universal 
Tracking Channelsa

Tracked Signals GPS: L1 C/A, L1C, L1P(Y), L2P(Y), L2C, L5
GLONASS: L1 C/A, L1P, L2P, L2C/A, L3
Galileo: E1, E5a, E5b, E5AltBOC
BeiDou: Phase 2: B1I, B2I; Phase 3: B1I, B1C, B2a, B2b
NavIC: SPS-L5A
SBAS: L1 C/A, L5
QZSS: L1 C/A, L1 C/B, L1C, L2C, L5
L-band: 1525-1560 MHz

Tracking

Multi-path Reduction Yes, code and carrier

PLL/DLL Settings Bandwidth, order, adjustable

SBAS WAAS/EGNOS/MSAS/GAGAN

Quartz Lock Loop (QLL) Protection against vibrations

Data

USB USB Micro-A/B
Device Mode - Mass storage, virtual serial

Input Formatb ● TPS proprietary 

● RTCM SC104 version 2.X, RTCM 3.X 

● Encrypted RTK

● CMR/CMR+

Output Formatb ● TPS proprietary

● RTCM SC104 version 2.X, RTCM 3.X (including MSM)

● CMR/CMR+

● BINEX

● NMEA 0183 versions 2.1, 2.2, 2.3, 3.0, 3.01, 4.0, 4.10, 4.11

Features Up to 20 Hz update rate for real time position and raw data

ASCII Output ASCII output NMEA 0183 versions 2.1, 2.2, 2.3, 3.0, 3.01, 4.0, 
4.10, 4.11

Table 9-1. General Receiver Specifications (Continued)

Item Specification



S
pecifications

General Details 9-4P/N: 1030371-01

Data Logging Support for sixteen simultaneous sessions
Advanced file/folder system

Memory

Type of Memory SD (Secure Digital) non-removable card

Capacity 8 GB pre-installed

Number of Files Up to 4000

Logging Size 6.0 MB per hour (32 SVs, 1-second, L1/L2, default message set)

Logging Interval 0.01 – 86,400 seconds, depending on purchased options

Output

Communication Ports ● High-speed RS-232 serial port (rimmed in green)

● USB 2.0 up to 480 Mbps
-USB device with mass storage and virtual serial port functionality

● Internal Cellular Module (optional)

Bluetooth Class 1; 
Up to 50 meters (indoor)

SiteComm Bluetooth 
Technology

Up to 328 meter range with up to 3 simultaneous rover 
connections. Typical long-range distance with clear line of sight. 
Distance for long-range largely depends upon environmental and 
field conditions. 

Serial Port Specifications RS-232 Serial Port:

● Baud rate: 460800, 230400, 115200 (default), 57600, 38400, 
19200, 9600, 4800, 2400, 1200, 600, 300

● Flow control: RTS/CTS

● Length: 7 or 8 (default)

● Stop bit: 1 (default), 2

● Parity: None (default), Odd, Even

Connectors ● UHF Modem Antenna (BNC)

● PWR

● RS-232 Serial

● USB 2.0 Micro-A/B

● External GNSS antenna or external cellular antenna

MINTER (LED Display) ● 6 external LEDs

● ON/OFF control input (power button)

NMEA

NMEA 0183 Output Version 2.x, 3.x and 4.x

Messages GGA, GLL, GMP, GNS, GRS, GSA, GST, GSV, HDT, RMS, ROT, 
VTG, UID and ZDA

Table 9-1. General Receiver Specifications (Continued)

Item Specification
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Output Interval 1-Hz standard; 5, 10, 20 Hz optional

DGPS

Correction Format RTCM SC104 Version 2.x and 3.x

RTCM Message Type 1, 3, 9, 31, 32, 34—user selectable

Process Interval 1-Hz standard; 10, 20 Hz optional

Output Interval for RTCM 
Correction Data

1-Hz standard; 10, 20 Hz optional

Elevation Mask 0 to 90 degrees (independent of data logging)

Real-Time Kinematic Mode

Correction Formatb RTCM SC104 Version 2.x, RTCM 3.x, RTCM 3.X MSM3,
CMR/CMR+ (Trimble compatible), TPS proprietary

Supported RTK Network 
Solutions

VRS, MAC, FKP

Ambiguity Initialization On-The-Fly (OTF): L1, L1/L2, L1/L2/L5

Baseline Length Up to 50 KM, depending on atmospheric and multi-path 
conditions

Initialize Time From 1-second depending on the baseline length (D) and multi-
path conditions

Output Interval for 
CMR/RTCM

1-Hz standard; 10, 20 Hz optional

Elevation 0 to 90 degrees (independent of data logging)

Solution Mode Delay (synchronization) mode
Extrapolation (not synchronized) mode

Process Interval 1-Hz standard; 10, 20 Hz optional

Survey Modes

Base or Rover Autonomous (standalone)
DGPS (w/user base)
DGPS (w/SBAS)
Static
Kinematic (continuous, stop and go)
RTK (delay, extrapolation)

Positional Accuracyc

Standalone Horizontal 1.2 meters
Vertical 1.8 meters

RTCM based DGPS Horizontal <0.25 meters
Vertical <0.50 meters

Table 9-1. General Receiver Specifications (Continued)

Item Specification
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SBAS Horizontal <1.0 meter 
Vertical <1.5 meter 

Topnet Live Starpoint (Pro) 
PPP correction serviced 

Horizontal <0.1 meters (95%) 
Vertical <0.2 meters (95%) 

Precision Static Horizontal 3 mm + 0.1 ppm
Vertical 3.5 mm + 0.4 ppm

Static/Fast Static Horizontal 3 mm + 0.4 ppm (x baseline length)
Vertical 5 mm + 0.5 ppm (x baseline length) 

RTK Static Horizontal 3 mm + 0.8 ppm (x baseline length) 
Vertical 5 mm + 1.0 ppm (x baseline length) 

RTK Kinematic 
/Stop&Go/Network

Horizontal 5 mm + 0.5 ppm (x baseline length)
Vertical 10 mm + 0.8 ppm (x baseline length) 

Kinematic, RTK,
Network RTK

L1+L2:
H: 5 mm + 0.5 ppm (x baseline length)
V: 10 mm + 0.8 ppm (x baseline length)

RTK, 
TILT Compensated

Horizontal 1.3 mm/°Tilt; Tilt 10°
Horizontal 1.8 mm/°Tilt; Tilt > 10° 
Maximum recommended angle for tilt compensation is 15°

Cold Start
Warm Start
Reacquisition

<40 seconds
<20 seconds
<1 second

RTK Time-to-First-Fix
(TTFF)

<20 seconds

a. Vanguard ASIC includes four additional dedicated channels for L-Band signal tracking.
b. CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and performance cannot be 

guaranteed. Use of industry standard RTCM 3.x is always recommended for optimal performance.
c. Subject to multi-path anomalies, interference, atmospheric conditions and atypical satellite geometry. GNSS survey 

best practices must always be applied.
d. Once converged

Table 9-1. General Receiver Specifications (Continued)

Item Specification
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R2 Lite UHF Internal Modem Board Details (Optional)
Table 9-2 lists GRX3’s optional R2 Lite UHF modem specifications.

General Recommendation for Highly Reliable Radio 
Links

1. Maintain the use of Forward Error Correction (FEC) when in challenging radio environments such 
as urban areas. FEC is the default option in the R2 Lite radio modem firmware. 

2. Use Received Signal Strength Indication (RSSI) to measure the radio environment before using 
GNSS receivers on a job site. RSSI values are available to our end users through our GNSS field 
application software and is an integral part of all GNSS systems. For more sensitive job sites like 
airport construction, our customers and professional service team members are trained to use a 
spectrum analyzer and other typical radio tools to ensure that the environment is free from radio 
signal jamming or interference. 

3. Co-operation with the local radio governing authorities to find out the optimum free radio 
channel. 

4. Avoid using channels nearby local TETRA or television frequencies, which are generally not 
recommended for use in this application. 

Table 9-2. R2 Lite UHF Internal Modem Board Specifications

Item Specification

Operating Frequency 
Range

406 – 470 MHz for Rover and Base

Channel Spacing 6.25 KHza/12.5 KHz/25 KHz user-selectable

a. 6.25 KHz Channel Spacing approved for Australia only.

Signal Modulation ● 4FSK

● GMSK

Communication Mode Time division duplex

Supported Protocol(s) TPS, PDL, Trimble, Satel 3AS

Transmitter Carrier Power 100, 200, 500 and 1000 mW, user selectable

Receiver Sensitivity GMSK: -115 dBm @ 10-5 BER and 12.5 KHz spacing

4FSK: -106 dBm @ 10-5 BER and 12.5 KHz spacing

Receiver Dynamic Range -110 to -10 dBm

Serial Data Rate 115200 bps

Radio Data Rate 25 KHz: 9600 bps for GFSK and 19200 bps for 4FSK
12.5 KHz: 4800 bps for GMSK and 9600 bps for 4FSK

Antenna Type Whip antenna

Antenna Connector BNC

Error Correction FEC on/off
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5. Use a repeater in an intermediate position, to extend the length of the link and/or increase the 
receive signal level at the rover. 

Adjacent Channel Selectivity 

If rare occurrence of base and rover receivers’ interference is reported, the user has the following 
options: 

1. Use an alternate licensed channel that is more than one channel away from the adjacent 
transmitter; or 

2. Decrease the distance to the transmitting base station by relocating the base closer to the rover 
position, thus increasing the signal level received at the rover by more than 6 dB. 

Receiver Spurious Response Rejection 

If the radio receiver is disturbed by a spurious frequency, one of the following proposal candidates 
can be used: 

1. Use an alternate licensed channel that is located farther away from the spurious frequency.

2. Decrease the distance to the transmitting base station by relocating the base closer to the rover 
position, thus increasing the signal level received at the rover by more than 4 dB. 

Bluetooth Module Details
Table 9-3 describes GRX3’s Bluetooth module specifications. 

Connector Specifications
GRX3 has one antenna connector for radio transmission/reception and four data and port connectors 
for power, serial communication, micro-USB and the external GNSS antenna or external cellular 
antenna. The SiteComm and Bluetooth antennas are internal.

Table 9-3. Bluetooth Module Specifications

Item Specification

Range Up to 50 meters/164.05 ft. (indoor); 
Up to 328.1 meters/1000 ft. (outdoor)

Type Class 1

Service Classes Miscellaneous

Supported Profiles SPP, SiteComm 

Frequency Country Code North America and Europe

NOTICE
Cellular models of the GRX3 have an external cellular module antenna connector 
(Figure 2-3 on page 2-2). 
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Radio (Modem) RF Connector
The modem connector (Table 9-4) is a BNC connector for UHF radio.

Cellular Module RF Connector
The cellular module connector specifications are listed below in Table 9-5.

Power Connector
The power connector (Figure 9-1) is a sealed receptacle, 5 pin, ODU (P/N G80F1C-T05QF00-0000).

Figure 9-1: Power Connector

Table 9-4. Modem Connector Specifications

Modem Type Signal Type Dir Details

UHF BNC Modem I/O I/O RF output from modem 
antenna

Table 9-5. Modem Connector Specifications

Module Type Signal Type Dir Details

Cellular SMA 
Connector

GSM/LTE I/O I/O RF input and output from 
cellular antenna
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Table 9-6 describes power connector specifications.

Serial RS-232 Connector
The Serial RS-232 connector (Figure 9-2) is a sealed receptacle, 7 pin, ODU 
(P/N G80F1C-T07QC00-0000).

Figure 9-2: Serial C RS-232 Connector

Table 9-7 describes the RS232 cable connector specifications.

Table 9-6. Power Connector Specifications

Number Signal Name Dir Details

1 Power_INP P 9 – 27 volts DC input

2 Power_INP P 9 – 27 volts DC input

3 Power_GND P Ground, power return

4 Power_GND P Ground, power return

5 Aux_Power P 9 – 27 volts DC input

Table 9-7. RS-232 Connector Specifications

Number Signal Name Dir Details

1 Not used

2 GND - Signal ground

3 CTS I Clear to send

4 RTS O Request to send

5 RXD I Receive data

6 TXD O Transmit data

7 PPS O 1-PPS
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Micro-USB Connector
The micro-USB connector is a standard 5-pin, micro-USB, A/B connector (Figure 9-3).

Figure 9-3: USB Connector for GGD Options

Table 9-8 describes the micro-USB connector specifications.

Table 9-8. Micro-USB Specifications

Number Signal Name Dir Details

1 USB_PWR P Bus power input

2 USB D- I/O Data minus

3 USB D+ I/O Data plus

4 ID I USB ID

5 GND P Ground
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Product Identification

The GRX3 receiver is available in the configurations and assembly part numbers shown in Table 10-1. 
The corresponding part numbers for the radio and cellular antennas to be paired with the receiver 
configuration are as indicated. 

NOTE Receiver assembly variants may differ based upon your country or region. 
Contact your local Sokkia dealer to inquire about availability in your area. 

Table 10-1. Assembly and Product Part Numbers

Assembly Part Number Radio Antenna P/N Cellular Antenna P/N

No radio, no cellular module

1028556-02
1028556-10
1028556-12

N/A N/A

R2 Lite UHF radio

1028556-01
1028556-09
1028556-11
1028556-20

30-050501-01 N/A

R2 Lite UHF radio, with integrated 4G/LTE cellular module

1028556-05
1028556-15

30-050501-01 1030630-01

Alinco UHF radio (available in Japan)

1028556-03 1014712-01 N/A

Alinco UHF radio (available in Japan), with integrated 4G/LTE cellular module

1028556-04 1014712-01 1030630-01
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Safety Warnings

General Warnings 

Battery Pack Warnings    

CAUTION
To comply with RF exposure requirements, maintain at least 37 cm between the 
user and the radio modem.

CAUTION

TPS receivers are designed for survey and survey related uses (that is, surveying 
coordinates, distances, angles and depths and recording such measurements). This 
product should never be used:
● Without the user thoroughly understanding this manual.

● After disabling safety systems or altering the product.

● With unauthorized accessories.

● Without proper safeguards at the survey site.

● Contrary to applicable laws, rules and regulations.

CAUTION
TPS receivers should never be used in dangerous environments. Use in rain or snow 
for a limited period is permitted.

CAUTION
Never attempt to open the casing of the internal battery! Lithium-Ion batteries can 
be dangerous if mishandled!

CAUTION
Do not incinerate or heat battery pack above 185 degrees Fahrenheit (85 degrees 
Celsius). Excessive heat can cause serious damage and possible explosion.

CAUTION

Tampering with the internal battery by end users or non-factory authorized 
technicians will void the battery’s warranty.
● Do not attempt to open the battery pack or replace it.

● Do not disassemble the battery pack.

● Do not charge in conditions different than specified.

● Do not use other than the specified battery charger.

● Do not short circuit.

● Do not crush or modify.

CAUTION Dispose of the battery in accordance with your local regulations.
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Receiver Warnings 

Usage Warnings 

CAUTION

Tampering with the receiver by the end users or non-factory authorized 
technicians will void the receiver’s warranty:
● Do not attempt to open the receiver and modify any of its internal components.

● Do not charge in conditions different than specified.

● Do not short circuit.

CAUTION

If this product has been dropped, altered, transported or shipped without proper 
packaging or otherwise treated without care, erroneous measurements may 
occur.

The surface of the unit may overheat under maximum operating temperature 
conditions. Use caution when operating under this condition. No impact on 
functionality will occur if operating within the temperature limit. See Table 9-1 on 
page 9-1 for operating temperatures.

The external AC/DC power supply adapter P/N 1005555-01 must not be used 
above 40°C air temperature.

The owner should periodically test this product to ensure it provides accurate 
measurements.

Inform TPS immediately if this product does not function properly.
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Regulatory

The chapter provides information about this product’s compliance with government regulations for 
use.

FCC Compliance
This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and 
meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment 
has very low levels of RF energy that it deemed to comply without maximum permissive exposure 
evaluation (MPE). But it is desirable that it should be installed and operated with at least 37 cm and 
more between the radiator and person’s body (excluding extremities: hands, wrists, feet and ankles). 

This equipment has been tested and found to comply with the limits for a Class A digital device 
pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

If this equipment does cause interference to radio or television equipment reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Move the equipment away from the receiver.

● Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.

● Consult the dealer or an experienced radio/television technician for additional suggestions

ISED Canada Compliance
This class A digital apparatus complies with Canadian ICES-003. 
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

This device complies with ISED Canada license-exempt RSS standard(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference and (2) this device must accept 
any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’ISED Canada applicables aux appareils radio exempts de 
licence. L’exploitation est autorisée aux deux conditions suivantes: (1) l’appareil ne doit pas produire 
de brouillage, et (2) l’utilisateur de l’appareil doit accepter tout brouilage radioélectrique subi, même si 
le brouillage est susceptible d’en compromettre le fonctionnement.

CAN ICES-3(A)/NMB-3(A)

CAUTION
Any changes or modifications to the equipment not expressly approved by the party 
responsible for compliance could void your authority to operate such equipment.
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Community of Europe Compliance
The product described in this manual is in compliance with the Radio Equipment Directive (RE-D) 
and EMC directives from the European Community.

European Community Declaration of Conformity
European Community Declaration of Conformity with Radio Equipment Directive 2014/53/EU

The following CE mark is affixed to the device: 

Restrictions on Use
The GRX3 UHF radio modem has been designed to operate only at specific frequencies. The exact 
frequency in use differs from one region and/or country to another. The user of a radio modem must 
take care that the said device is not operated without the permission of the local authorities on 
frequencies other than those specifically reserved and intended for use without a specific permit. 

The GRX3 UHF (406-470 MHz) is allowed to be used in the following countries, either on license free 
channels or on channels where the operation requires a license. Additional detailed information is 
available at the local frequency management authority. 

Product Conformity
Hereby, Sokkia declares that the GRX3 radio modem is in compliance with the essential 
requirements (radio performance, electromagnetic compatibility and electrical safety) and other 
relevant provisions described in Directive 2014/53/EU. 

Therefore, the equipment is labeled with the CE-marking. The operating frequency range of the 
device is not harmonized throughout the market area and the local spectrum authority should be 
contacted prior to use.

CAUTION
This is a Class A product. In a domestic environment this product may cause radio 
interference in which case the user may be required to take adequate measures.

NOTICE
The countries affected by the GRX3 restrictions in use are: AT, BE, BG, CY, DK, FI, 
FR, DE, GR, IS, IE, IT, LU, MT, NL, NO, ES, SE, CH, GB, AU, CA, CZ, EE, HU, LV, LT, 
PL, PT, RO, SI, SK, ZA, TR, HR and US.
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Declaration of Conformity 
(Radio Equipment Directive 2014/53/EU)
esky 
[Czech]

(Sokkia) tímto prohlašuje, že tento (GRX3) je ve shod se 
základními požadavky a dalšími píslušnými ustanoveními 
smrnice 2014/53/ES.

Dansk 
[Danish]

Undertegnede (Sokkia) erklærer herved, at følgende udstyr 
(GRX3) overholder de væsentlige krav og øvrige relevante 
krav i direktiv 2014/53/EF.

Deutsch 
[German]

Hiermit erklärt (Sokkia) dass sich das Gerät (GRX3) in 
Übereinstimmung mit den grundlegenden Anforderungen 
und den übrigen einschlägigen Bestimmungen der 
Richtlinie 2014/53/EG befindet.

Eesti 
[Estonian]

Käesolevaga kinnitab (Sokkia) seadme (GRX3) vastavust 
direktiivi 2014/53/EÜ põhinõuetele ja nimetatud direktiivist 
tulenevatele teistele asjakohastele sätetele.

English Hereby, (Sokkia) declares that this (GRX3) is in compliance 
with the essential requirements and other relevant 
provisions of Directive 2014/53/EC.

Español 
[Spanish]

Por medio de la presente (Sokkia) declara que el (GRX3) 
cumple con los requisitos esenciales y cualesquiera otras 
disposiciones aplicables o exigibles de la Directiva 
2014/53/CE.

Ελληνικά
[Greek]

(Sokkia) δια του παρούσα δηλώνει ότι (GRX3) είναι 
σύμφωνα με τις απαιτήσεις και άλλες σχετικές διατάξεις 
της οδηγίας 2014/53/ΕΚ.

Français 
[French]

Par la présente (Sokkia) déclare que l'appareil (GRX3) est 
conforme aux exigences essentielles et aux autres 
dispositions pertinentes de la directive 2014/53/CE.

Italiano 
[Italian]

Con la presente (Sokkia) dichiara che questo (GRX3) è 
conforme ai requisiti essenziali ed alle altre disposizioni 
pertinenti stabilite dalla direttiva 2014/53/CE.

Latviski 
[Latvian]

Ar šo (Sokkia) deklar, ka (GRX3) atbilst Direktvas 
2014/53/EK btiskajm prasbm un citiem ar to saisttajiem 
noteikumiem.

Lietuvi 
[Lithuanian] 

Šiuo (Sokkia) deklaruoja, kad šis (GRX3) atitinka esminius 
reikalavimus ir kitas 2014/53/EB Direktyvos nuostatas.

Nederlands 
[Dutch]

Hierbij verklaart (Sokkia) dat het toestel (GRX3) in 
overeenstemming is met de essentiële eisen en de andere 
relevante bepalingen van richtlijn 2014/53/EG.

Malti 
[Maltese]

Hawnhekk, (Sokkia), jiddikjara li dan (GRX3) jikkonforma 
mal-tiijiet essenzjali u ma provvedimenti orajn relevanti li 
hemm fid-Dirrettiva 2014/53/EC.

Magyar 
[Hungarian]

Alulírott, (Sokkia) nyilatkozom, hogy a (GRX3) megfelel a 
vonatkozó alapvetõ követelményeknek és az 2014/53/EC 
irányelv egyéb elõírásainak.
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WEEE Directive
Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By 
ensuring this product is disposed of correctly, to help prevent potential negative consequences for 
the environment and human health, which could otherwise be caused by inappropriate waste 
handling of this product. For more detailed information about the take-back and recycling of this 
product, please contact a supplier where you purchased the product or consult.

Japan Bluetooth SiteComm Module Compliance
The integrated Bluetooth SiteComm module reference application described on page 61 
complies in accordance with the provisions of Article 38-24 paragraph 1 of Japan Radio Law. The 
certificate granted in accordance with Japan Radio Law has the identifier R 209-J00231 
(Bluetooth SiteComm) or R 201-180688.

Polski 
[Polish]

 Niniejszym, (Sokkia), deklaruj, e (GRX3) spenia wymagania 
zasadnicze oraz stosowne postanowienia zawarte 
Dyrektywie 2014/53/EC.

Português 
[Portugues]

(Sokkia) declara que este (GRX3) está conforme com os 
requisitos essenciais e outras disposições da Directiva 
2014/53/CE.

Slovensko 
[Slovenian]

(Sokkia) izjavlja, da je ta (GRX3) v skladu z bistvenimi 
zahtevami in ostalimi relevantnimi doloili direktive 
2014/53/ES.

Slovensy 
[Slovak]

(Sokkia) týmto vyhlasuje, že (GRX3) spa základné 
požiadavky a všetky príslušné ustanovenia Smernice 
2014/53/ES.

Suomi 
[Finnish]

(Sokkia) vakuuttaa täten että (GRX3) tyyppinen laite on 
direktiivin 2014/53/EY oleellisten vaatimusten ja sitä 
koskevien direktiivin muiden ehtojen mukainen.

Svenska 
[Swedish]

Härmed intygar (Sokkia) att denna (GRX3) står I 
överensstämmelse med de väsentliga egenskapskrav och 
övriga relevanta bestämmelser som framgår av direktiv 
2014/53/EG.
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Bluetooth Transmission Statements/Compliance
This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

● Baseband

● HCI

● Link Manager

● Radio

The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification 
is valid for any antenna with the same or less gain.
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Warranty

Sokkia laser and electronic positioning equipment are guaranteed against defects in material and 
workmanship under normal use and in applications consistent with this Manual. The equipment is 
guaranteed for the period indicated, on the warranty card accompanying this product and starting from 
the date that this product is sold to the original purchaser by an Sokkia dealer.1

During the warranty period, Sokkia will, at its option, repair or replace this product at no additional 
charge. Repair parts and replacement products will be furnished on an exchange basis and will be 
either reconditioned or new. This limited warranty does not include service to repair damage to the 
product resulting from an accident, disaster, misuse, abuse or modification of the product.

Warranty service may be obtained from an authorized Sokkia warranty service dealer. If this product is 
delivered by mail, the purchaser agrees to insure the product or assume the risk of loss or damage in 
transit, to prepay shipping charges to the warranty service location and to use the original shipping 
container or equivalent. A letter should accompany the package furnishing a description of the 
problem and/or defect.

The purchaser’s sole remedy shall be replacement as described above. In no event shall Sokkia be 
liable for any damages or other claims including any claim for lost profits, lost savings, or other 
incidental or consequential damages arising out of the use of, or inability to use, the product.
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Glossary

B

BDS—BeiDou Navigation Satellite System maintained and operated by China. See also, BeiDou.

Base Station—A GNSS receiver set up over a known point, which is used to derive correction 
information for nearby Rover (mobile) GNSS receivers.

BeiDou—Navigation Satellite System maintained and operated by China. See also, BDS.

Bluetooth—Often used in place of cables, Bluetooth is open wireless technology for exchanging data 
over short distances from fixed and/or mobile devices. 

E

Ephemeris Data—A table or data file showing the calculated positions of a celestial object.

G

GALILEO—The satellite system currently maintained and operated by the European Union (EU) and 
European Space Agency (ESA).

GGD—GPS + GLONASS Dual Frequency signal tracking.

GNSS—Global Navigation Satellite System. 

GNSS Receiver—GNSS Receivers determine the user position, velocity and precise time by 
processing broadcasted signals from global satellites.

GLONASS—The GLObal NAvigation Satellite System maintained and operated by the Russian 
Federation.

GPS—The Global Positioning System maintained and operated by the United States Department of 
Defense.

L

L1—The primary L-band carrier used by GPS, GLONASS and QZSS satellites to transmit satellite data.

L2—The secondary L-band carrier used by GPS, GLONASS and QZSS satellites to transmit satellite 
data.

Light Emitting Diodes (LEDs)—These LEDs are used as indicator lights on the GRX3 receiver to 
display the status of the receiver’s components and to control receiver operations.

M

MAGNET Field—Field application software used to collect survey mapping data for use by total 
stations, levels and GNSS receivers. 

MAGNET Office—Post-processing and CAD solution software for surveying and grade application. It 
is part of the MAGNET software system. 

MINTER—The receiver’s Minimum INTERface used to display and control data input and output.
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N

Network Real Time Kinematic (RTK)—a satellite navigation technique used to enhance the 
precision of position data derived from satellite-based positioning systems such as GPS, 
GLONASS, Galileo, BeiDou, QZSS, and NavIC systems.

O

Option Authorization File (OAF)—This enables the specific features that a customer purchases.

P

Phase Center of Antenna—The point from which the electromagnetic radiation spreads spherically 
outward, with the phase of the signal being equal at any point on the sphere.

Pocket 3D—Field controller software (made by Topcon) that supports both GNSS and Total Station 
measurements.

R

Real Time Kinematic (RTK)—A precise method of real-time surveying. RTK enables you to check 
the measurement quality without having to process the data. 

Rover—A mobile GNSS receiver and data collector used for determining field location.

S

Satellite Based Augmentation Systems (SBAS)—SBAS transmits differential corrections and 
messages for navigation satellites that are within sight of a network or a reference station in a wide 
area—such as a continent.

Sokkia Receiver Utility (SRU)—Hardware configuration software designed for GNSS receivers and 
peripheral devices. SRU software can be downloaded from the Sokkia Care site: 
https://us.sokkia.com/sokkia-care-products/sru-sokkia-receiver-utility.

Static Survey—Typically uses a network or multiple baseline for positioning. The static survey 
method provides the highest accuracy and requires the longest observation times.

U

Universal Serial Bus (USB)—An industry connection standard used by devices, such as a receiver 
or controller to connect to a computer.

https://us.sokkia.com/sokkia-care-products/sru-sokkia-receiver-utility 
https://us.sokkia.com/sokkia-care-products/sru-sokkia-receiver-utility 
https://us.sokkia.com/sokkia-care-products/sru-sokkia-receiver-utility 


Concerns regarding this Sokkia product may be sent to Service and Repair Department,  
Topcon Positioning Systems, Inc., 7400 National Drive, Livermore, California 94550

Concerns regarding this Sokkia product may be sent to Service and Repair Department,  
Topcon Positioning Systems, Inc., 7400 National Drive, Livermore, California 94550
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